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Thank you for purchasing the Lorex wireless video monitoring system.

This manual refers to the following models:

• LW2710 Series (7‘‘ wireless monitoring system)

• LW2910 Series (9‘‘ wireless monitoring system)

 
To learn more about this product and to learn about our complete range of accessory 
products, please visit our website at:

www.lorextechnology.com

CAUTION  

RISK OF ELECTRIC SHOCK
DO NOT OPEN

CAUTION: TO REDUCE THE RICK OF ELECTRIC SHOCK DO NOT 
REMOVE COVER. NO USER SERVICABLE PARTS INSIDE.

REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, within an equilateral 
triangle, is intended to alert the user to the presence of uninsulated 
"dangerous voltage" within the products ' enclosure that may be of 
sufficient magnitude to constitute a risk of electric shock.
The exclamation point within an equilateral triangle is intended to 
alert the user to the presence of important operating and 
maintenance (servicing) instructions in the literature accompanying 
the appliance.

WARNING: TO PREVENT FIRE OR SHOCK HAZARD, DO NOT 
EXPOSE THIS UNIT TO RAIN OR MOISTURE.

CAUTION: TO PREVENT ELECTRIC SHOCK, MATCH WIDE BLADE 
OF THE PLUG TO THE WIDE SLOT AND FULLY INSERT.

http://www.lorexcctv.com
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LOREX IS COMMITTED TO FULFILLING YOUR SECURITY NEEDS

• We have developed user friendly products and documentation.

   Please read the Quick Start Guide and User Manual before you 

   install this product.

• Consumer Guides and Video Tutorials are available on our web

   site at www.lorextechnology.com/support

• If you require further installation assistance, please visit 

   www.lorextechnology.com/installation or contact a 

   professional installer. 

• Please refer to the “Need Help” insert for technical support and 

   customer care information.

• Please note that once the components of this product have been 

   unsealed, you cannot return this product directly to the store 

   without the original packaging.

THIS PRODUCT MAY REQUIRE PROFESSIONAL INSTALLATION

BEFORE YOU START
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LOREX SE COMPROMETE A SATISFACER 
SUS NECESIDADES EN SEGURIDAD

LOREX S’ENGAGE À SATISFAIRE 
VOS BESOINS SÉCURITAIRES

ESTE PRODUCTO PUEDE EXIGIR UNA 
INSTALACIÓN PROFESIONAL

CE PRODUIT POURRAIT EXIGER UNE 
INSTALLATION PROFESSIONNELLE

• Veuillez lire le guide de démarrage rapide et le 
mode d’emploi avant d’installer ce produit

• Les guides du consommateur et les séances de tu-
torat vidéo sont disponibles sur l’Internet en visitant 
www.lorextechnology.com/support

• Si vous avez besoin de l’aide pour l’installation, 
veuillez visiter www.lorextechnology.com/installa-
tion ou contactez un spécialiste en installation

• Veuillez référer à l’insert “Need Help” pour 
ob¬tenir de l’information sur le service à la clientèle 
et le support technique

• Veuillez constater qu’une fois que les 
com¬posantes de ce produit ont été retirées de 
l’emballage, vous ne pourrez plus retourner ce 
produit directement au magasi

• Favor de leer la guía de instalación rápida y la 
guía del usuario antes de instalar este product.

• Puede conseguir las guías del consumidor y los 
cursos en enseñanza video sobre el Internet visi-
tando www.lorexcctv.com/support

• Si necesita ayuda para la instalación, visite  
www.lorextechnology.com/installation o contacte 
un especialista en instalaciones

• Favor de referir al documento “Need Help” para 
obtener información acerca del servicio al cliente y 
al soporte técnico

• Favor de notar que una vez que los componentes 
de este producto han sido removidos del embalaje, 
no podrá devolver este producto directamente a la 
tienda

AVANT DE 
COMMENCER

ANTES DE 
EMPEZAR

ALWAYS AWARE™
TOUJOURS AU COURANTMD

SIEMPRE CONSCIENTE™

VIEW YOUR WORLD™
VOIR VOTRE MONDEMD

VER SUMUNDO™

www.lorextechnology.com
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North America:
Customer Service: 1-888-425-6739 (1-888-42-LOREX)
Tech Support: 1-877-755-6739 (1-877-75-LOREX)
Mexico: 1-800-514-6739
International:  +800-425-6739-0
(Example: From the UK, dial 00 instead of +)

By Phone:

Technical Support (for technical/installation issues)
support@lorexcorp.com

By Email:

Customer Care (for warranty and accessory sales)
customerservice@lorexcorp.com
Customer Feedback
info@lorexcorp.com

Need Help?
CONTACT US FIRST

Online:

To order accessories, visit
www.lorextechnology.com

3 Easy Ways to Contact Us:

Please make sure to register your product at www.lorextechnology.com
to receive product updates and information

Product Support is available 24/7 including product  
information, user manuals, quick start up guides and FAQ’s at 
www.lorextechnology.com/support

DO NOT RETURN THIS PRODUCT TO THE STORE
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Necesita Ayuda
COMUNÍQUESE PRIMERO 
CON NOSOTROS

Vous Avez Besoin 
D’aide?
CONTACTEZ-NOUS 
D’ABORD

3 façons faciles de nous contacter:

L’Amérique du Nord:
Service à la clientèle: 1-888-425-6739 (1-888-42-LOREX)
Support technique: 1-877-755-6739 (1-877-75-LOREX)
Mexico: 1-800-514-6739

International: +800-425-6739-0

(Exemple: À partir du Royaume-Uni, composez 00 au lieu de +) 

Par Téléphone:

Veuillez veiller à enregistrer votre produit à www.lorex-
cctv.com/registration pour recevoir des mises à jour et 
l’information de produit

Pour commander des accessoires, visitez 
www.lorextechnology.com

le support des produits est disponible 24 heures sur 24, 7 
jours sur 7, y compris les informations sur les produits, les 
guides de l’utilisateur, les guides de démarrage rapide et les 
foires à questions
www.lorextechnology.com/support

En ligne:

Commentaires des clients 
info@lorexcorp.com

support technique (pour les questions techniques et ’installa-
tion) support@lorexcorp.com

Par Courriel:

service à la clientèle (pour les questions de garantie 
et les ventes d’accessoires) 
customerservice@lorexcorp.com

OU

3 maneras sencillas de comunicarse con 
nosotros:

Norte América:
Atención al cliente: 1-888-425-6739 (1-888-42-LOREX)
Soporte técnico: 1-877-755-6739 (1-877-75-LOREX)
Mexico: 1-800-514-6739

Internacional: +800-425-6739-0

(Ejemplo: Desde el Reino Unido, marque el 00 en lugar del +)

Por Teléfono:

apoyo al producto disponible 24/7 incluyendo información 
del producto, manuales para el usuario, guías de inicio 
rápido y preguntas más frecuentes en 
www.lorextechnology.com/support

En línea:

Cerciórese de por favor colocar su producto en www.
lorexcctv.com/registration para recibir actualizacio-
nes y la información del producto

Para colocar pedidos de accesorios, visite
www.lorextechnology.com

soporte técnico (para asuntos técnicos/la instalación)
support@lorexcorp.com

Por Correo Electrónico:

servicio al cliente (respecto a la garantía y a la venta 
de accesorios)
customerservice@lorexcorp.com

O

Comentarios de cliente 
info@lorexcorp.com

NO DEVUELVA ESTE PRODUCTO A LA TIENDA NE RETOURNEZ PAS CE PRODUIT AU MAGASIN

VIEW YOUR WORLD™
VOIR VOTRE MONDEMD

VER SUMUNDO™ ALWAYS AWARE™
TOUJOURS AU COURANTMD

SIEMPRE CONSCIENTE™

SIMPLY AWARE™
SIMPLEMENT AU COURANTMD

SIMPLEMENTE CONSCIENTE™



Important Safeguards

In addition to the careful attention devoted to quality standards in the manufacture process of your 
video product, safety is a major factor in the design of every instrument. However, safety is your 
responsibility too. This sheet lists important information that will help to assure your enjoyment 
and proper use of the video product and accessory equipment. Please read them carefully before 
operating and using your video product.

Installation
1. Read and Follow Instructions - All the safety and 

operating instructions should be read before the 
video product is operated. Follow all operating 
instructions.

2. Retain Instructions - The safety and operating 
instructions should be retained for future reference.

3.   Heed Warnings - Comply with all warnings on the 
video product and in the operating instructions.

4. Polarization - Do not defeat the safety purpose of the 
polarized or grounding-type plug.

A polarized plug has two blades with 
one wider than the other.

A grounding type plug has two blades 
and a third grounding prong.

The wide blade or the third prong are 
provided for your safety.

If the provided plug does not fit into 
your outlet, consult an electrician for 
replacement of the obsolete outlet.

5. Power Sources - This video product should be 
operated only from the type of power source 
indicated on the marking label. If you are not sure of 
the type of power supply to your location, consult 
your video dealer or local power company. For video 
products intended to operate from battery power, or 
other sources, refer to the operating instructions.

6. Overloading - Do not overload wall outlets of 
extension cords as this can result in the risk of fire 
or electric shock. Overloaded AC outlets, extension 
cords, frayed power cords, damaged or cracked wire 
insulation, and broken plugs are dangerous. They 
may result in a shock or fire hazard. Periodically 
examine the cord, and if its appearance indicates 
damage or deteriorated insulation, have it replaced 
by your service technician.

7. Power-Cord Protection - Power supply cords should 
be routed so that they are not likely to be walked on 
or pinched by items placed upon or against them, 
paying particular attention to cords at plugs, 
convenience receptacles, and the point where they 
exit from the video product.

8.   Ventilation - Slots and openings in the case are 
provided for ventilation to ensure reliable operation 
of the video product and to protect it from 
overheating. These openings must not be blocked or 
covered. The openings should never be blocked by 
placing the video equipment on a bed, sofa, rug, or 
other similar surface. This video product should 
never be placed near or over a radiator or heat 
register. This video product should not be placed in 
a built-in installation such as a bookcase or rack 
unless proper ventilation is provided or the video 
product manufacturer’s instructions have been 
followed.

9. Attachments - Do not use attachments unless 
recommended by the video product manufacturer as 
they may cause a hazard.

10. Camera Extension Cables – Check the rating of your 
extension cable(s) to verify compliance with your 
local authority regulations prior to installation.

11. Water and Moisture - Do not use this video product 
near water. For example, near a bath tub, wash bowl, 
kitchen sink or laundry tub, in a wet basement, near 
a swimming pool and the like. 

Caution: Maintain electrical safety. Power line 
operated equipment or accessories connected to 
this unit should bear the UL listing mark of CSA 
certification mark on the accessory itself and should 
not be modified so as to defeat the safety features. 
This will help avoid any potential hazard from 
electrical shock or fire. If in doubt, contact qualified 
service personnel.

12. Accessories - Do not place this 
video equipment on an unstable 
cart, stand, tripod, or table. The 
video equipment may fall, causing 
serious damage to the video 
product. Use this video product 
only with a cart, stand, tripod, 
bracket, or table recommended by the manufacturer 
or sold with the video product. Any mounting of the 
product should follow the manufacturer’s 
instructions and use a mounting accessory 
recommended by the manufacturer.
vii



 

Service
13. Servicing - Do not attempt to service this video 

equipment yourself as opening or removing covers 
may expose you to dangerous voltage or other 
hazards. Refer all servicing to qualified service 
personnel.

14. Conditions Requiring Service - Unplug this video 
product from the wall outlet and refer servicing to 
qualified service personnel under the following 
conditions.

A. When the power supply cord or plug is 
damaged.

B. If liquid has been spilled or objects have fallen 
into the video product.

C. If the video product has been exposed to rain 
or water.

D. If the video product does not operate normally 
by following the operating instructions. Adjust 
only those controls that are covered by the 
operating instructions. Improper adjustment of 
other controls may result in damage and will 
often require extensive work by a qualified 
technician to restore the video product to its 
normal operation.

E. If the video product has been dropped or the 
cabinet has been damaged.

F. When the video product exhibits a distinct 
change in performance. This indicates a need for 
service.

15. Replacement Parts - When replacement parts are 
required, have the service technician verify that the 
replacements used have the same safety 
characteristics as the original parts. Use of 
replacements specified by the video product 
manufacturer can prevent fire, electric shock or 
other hazards.

16. Safety Check - Upon completion of any service or 
repairs to this video product, ask the service 
technician to perform safety checks recommended 
by the manufacturer to determine that the video 
product is in safe operating condition.

17. Wall or Ceiling Mounting - The cameras provided 
with this system should be mounted to a wall or 
ceiling only as instructed in this guide, using the 
provided mounting brackets.

18. Heat - The product should be situated away from 
heat sources such as radiators, heat registers, 
stoves, or other products (including amplifiers) that 
produce heat.

Use
19. Cleaning - Unplug the video product from the wall 

outlet before cleaning. Do not use liquid cleaners or 
aerosol cleaners. Use a damp cloth for cleaning.

20. Product and Cart Combination - Video and cart 
combination should be moved with care. Quick stops, 
excessive force, and uneven surfaces may cause the 
video product and car combination to overturn.

21. Object and Liquid Entry - Never push objects for any 
kind into this video product through openings as they 
may touch dangerous voltage points or “short-out” 
parts that could result in a fire or electric shock. 
Never spill liquid of any kind on the video product.

22. Lightning - For added protection for this video 
product during a lightning storm, or when it is left 
unattended and unused for long periods of time, 
unplug it from the wall outlet and disconnect the 
antenna or cable system. This will prevent damage 
to the video product due to lightning and power line 
surges.
viii



General Precautions

1. All warnings and instructions in this manual should be followed.
2. Remove the plug from the outlet before cleaning. Do not use liquid aerosol detergents. Use a 

water dampened cloth for cleaning.
3. Do not use this unit in humid or wet places.
4. Keep enough space around the unit for ventilation. Slots and openings in the storage cabinet 

should not be blocked.
5. During lightning storms, or when the unit is not used for a long time, disconnect the power 

supply, antenna, and cables to protect the unit from electrical surge.

This equipment has been certified and found to comply with the limits regulated by FCC, EMC, and 
LVD. Therefore, it is designated to provide reasonable protection against interference and will not 
cause interference with other appliance usage.

However, it is imperative that the user follows this manuals guideline to avoid improper usage 
which may result in damage to the unit, electrical shock and fire hazard injury

In order to improve the feature functions and quality of this product, the specifications are subject 
to change without notice from time to time.

FCC CLASS B NOTICE

Note

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, and can radiate radio frequency 
energy and, if not in-stalled and used in accordance with the instruction, may cause harmful interference to 
radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment 
does cause harmful interference to radio or television reception (which can be determined by turning the 
equipment on and off), the user is encouraged to try to correct the interference by one or more of the following 
measures:

• Reorient or relocate the receiving antenna
• Increase the separation between the equipment and receiver
• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected
• Consult the dealer or an experienced radio or television technician for assistance

www.lorextechnology.com
ix



 

Features

LCD Receiver Features

• Simple installation. No video cables required ready for basic remote connectivity* 1

• Integrated digital video recorder, SD™ memory card included
• Multiple recording options: manual, motion or schedule 2
• Time and date stamped recordings for easy retrieval
• Simulated picture frame using pre-programmed images 3
• 2-way Audio communication for Intercom usage
• Night viewing up to 40ft (12m) 4
• View up to 4 cameras at the same time or in sequence
• Up to 150ft indoor/450ft outdoor wireless range 6
• Tabletop, wall or under-counter mountable monitor

Camera Features

• VGA (640x480) Resolution Camera
• IR Night Vision up to 40ft/12m 4
• Install cameras indoors or outdoors 5
• IR Cut Filter for accurate color reproduction under all lighting conditions
• Built-in PIR motion sensor for accurate motion detection
• Durable indoor/outdoor housing ideal for indoor/outdoor use 5
• Built-in microphone and speaker for listening and speaking
• SMA connector allows for the usage of higher power antennas to extend wireless range 

(antennas sold separately).

1. Cameras require a local power outlet.
2. Local viewing up to 4 cameras simultaneously. Local recording and playback of one camera at a time.
3. Five preloaded scenery images enable digital picture frame simulation when no motion is detected by the camera. When motion 

is detected, image changes to the camera detecting motion. No ability to upload your own pictures.
4. Stated IR Illumination range is based on ideal conditions. Actual range and image clarity depends on installation location, 

viewing area and light reflection/absorption level of object.
5. Weather resistant. Not intended for direct exposure to rain or snow. For outdoor applications install under shelter protected 

from the elements.
6. Based on line of sight. Actual range will vary depending on obstructions.

* Remote connection requires driver installation on home PC (CD included), a wired USB connection between the monitor and PC (USB 
cable included) and a high speed internet connection.

• PC must be turned ON and Skype™ application must be running. Remote viewing is limited to a single camera and is not selectable 
remotely.
x
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Getting Started
The system includes the following components:

Two way audio 
outdoor camera*

LCD monitor / 
Wireless receiver*

Remote Control

SD Memory card** Power adapter(s) for 
receiver and camera(s)*

Audio/video cable

Table top stand Camera 
mounting 
stand*

Under the counter 
mounting kit

Wireless antennas (for 
camera and receiver)*

Mounting kit(s)*

*Configuration may vary by model.

USB cable Software CD

**Optional SD card. Consult your package for content details.

CAMERA CONFIGURATION, MONITOR SIZE, AND NUMBER OF ACCESSORIES MAY VARY BY 
MODEL. PLEASE REFER TO YOUR PACKAGE FOR SPECIFIC DETAILS. 
CHECK YOUR PACKAGE TO CONFIRM THAT YOU HAVE RECEIVED THE COMPLETE SYSTEM.
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LCD Monitor/ Receiver overview

1 Wireless Antenna: Position the antenna as needed for best reception.

2 Wall Hanger: Use hole to hang the LCD Receiver like a picture frame.

3 Mounting Hole: Attach the included under-the-counter mount to mount the LCD Receiver 
underneath a counter/cupboard, wall, or ceiling.

4 Speaker: Speaker for two-way audio.

5 SD Card Slot: Insert up to a 16GB SD card.

6 USB Port:  Used for Skype connectivity. For details see, page 39.

7 AV OUT: Connect the Audio/Video cable to view video on an external TV or monitor (optional)

8 Support Stand: Attach the included support stand to position the LCD receiver like a picture 
frame.

9 DC5V: Connect the included power adapter.

10 Microphone: Microphone for two-way audio.

11 TALK: Press to talk using the Intercom; release to listen.

12 Channels/Navigation Joystick: Press to open the Main 
Menu. Use to change channels within quad view.

13 MENU: Press to open the main menu.

14 Power: Slide button to turn the LCD receiver ON/OFF*

1 2 3 4

5

6

7

9

11

12

13

14

810

*LW2910 Series uses a slide switch located 
on the side panel.
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Using the Joystick to change channels
To change channels during Quad mode:
Move UP to view camera 1, RIGHT (2) to view camera 2, DOWN (3) to view camera 3, and 
LEFT (4) to view camera 4; move UP/DOWN/LEFT/RIGHT to navigate menus; press the 
joystick to confirm menu selections.

Camera overview

1 Lens: Camera lens.

2 Microphone: Built-in microphone underneath camera body.

3 PIR Sensor: Passive IR motion sensor for more accurate motion recording.

4 Speaker: Speaker for two-way audio.

5 Night Vision IR: Night vision IR LEDs used for viewing in complete darkness.

6 Pair: Pairing button. For more details, see “Appendix C: Adding Cameras” on page 33.

7 Antenna: Wireless antenna.

8 Power Cable: Connect the included power adapter to the cable extending from the camera.

1

2

3

5

6
7

84

This camera includes an Auto Mechanical IR Cut Filter. When the 
camera changes between day/night lighting, an audible clicking 
noise may be heard coming from the camera. This clicking is normal, 
and indicates that the camera filter is working.

ATTENTION
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Getting Started
Remote Control
1 1 / /�: Move menu cursor UP; 

change time settings; start/pause 
playback; jump to camera 1 while in 
Quad Mode.

2 Enter: Confirm menu selections.

3 4/�: Move menu cursor LEFT; 
rewind playback; jump to camera 4 
while in Quad Mode; decrease 

4 MENU / Back: Press to open the 
Main Menu; close menu windows.

5 Record: Press Motion to enable 
motion recording - system will 
ONLY record when motion is 
detected; press to start/stop 
manual recording.

6 Volume: Increase/decrease volume 
of two-way audio from the receiver; 
increase/decrease volume during 
playback.

7 Quad: Press to change the display view to quad (4-way) split-screen.

8 2/ �: Move menu cursor RIGHT; increase playback speed; jump to camera 2 while in Quad 
Mode; increase values in certain menu options.

9 3/ : Move menu cursor DOWN; change time settings; stop playback; jump to camera 3 while 
in Quad Mode.

10 Scan/Del: Press to enable/disable Screen Saver mode; delete recorded video files.

11 Channel: Press "A" to enable/disable automatic sequence; press M to manually change the 
channels (1~4).

12 AV: Press to send the image to a connected TV or monitor (AV cable required)

NOTE: Screen Saver Mode is not available if using AV-out.

1

2

3

4

5

6

7

8

9

10

11

12
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Installing the camera
Installing the camera
Before you install the camera, plan where and how it will be positioned, and where you will 
route the cable that connects the camera to the power adapter. 

• Before starting permanent installation, verify its performance by observing the image on a 
monitor when camera is positioned in the same location/position where it will be permanently 
installed 

• The cameras are pre-paired so they work out of the box. Each camera has a channel number 
sticker indicating what channel they are paired to. To manually pair your cameras, see 
“Appendix C: Adding Cameras” on page 33.

To install the camera
1 Use the included mounting screws to mount the stand to the mounting surface: 

• Mark the position of the screw holes on the wall
• Drill holes and insert the drywall plugs as needed
• Firmly attach the stand to the wall using the provided screws

Installation Warnings

• Mount the camera indoors or outdoors. For outdoor installation, mount 
it in a sheltered place where it is not directly exposed to rain or snow.

• Aim the Cameras to best optimize the viewing area: Select a location for 
the camera that provides a clear view of the area you want to monitor, 
which is free from dust, and is not in line-of-sight to a strong light source 
or direct sunlight.

• Place the camera within 21 feet (6.5 meters) of the area you wish to monitor 
for motion during night time. This allows for optimal motion detection.

• Avoid installing the cameras where there are thick walls or obstructions 
between the Cameras and the Receiver

• Select a location for the camera that has an ambient temperature between 
14°F~122°F (-10°C ~ 50°C)
5



Installing the camera
2 Twist the antenna clockwise onto the antenna port on the side of the camera.

3 Attach the camera to the mounting stand. Adjust the angle of the camera until the desired 
view is set. Tighten the thumbscrews to secure the desired camera position.

4 Connect the black power cable extending from the camera to the cable of the power adapter; 
plug in the power adapter to an outlet or surge protector.

NOTE: You can install additional cameras (maximum of 4 cameras). When adding cameras 
that were not included in the original box, you will need to pair the cameras with 
the receiver. For details,see “Appendix C: Adding Cameras” on page 33.

Connect antenna

Connect camera stand

Tighten thumb screws
6



Installing the camera
Mounting the LCD Receiver
The LCD Receiver can be setup for use on a tabletop, or mounted to a wall or underneath 
a counter or cupboard.

Table Mounting
To table mount the receiver:

1 Attach the Tabletop Stand to the slot on the rear panel and turn counter clockwise until you 
hear one "click." Continue turning counter clockwise to position the LCD receiver as desired.

Under-the-Counter, Wall, or Ceiling Mounting
1 Select a location to mount the receiver, i.e. under a counter or cupboard, wall or ceiling.  The 

location should have a clear reception to your camera. Place the mounting stand in the 
desired mounting position and mark holes for the screws.

NOTE: Avoid installing in a location which requires the wireless signal to pass through 
cement, concrete, and metal structures. This will reduce the range of transmission.

2 Drill the holes, and then mount the stand to the desired surface using the provided screws. 
Make sure all three screws are fastened tightly at the connection points.

3 Adjust the antenna on the LCD receiver to allow for proper clearance with your mounting 
surface.

4 Attach the LCD receiver to the mounting stand. Adjust the position of the LCD receiver and 
tighten the bolts with included Allen key.
7



Installing the camera
Basic Setup

Installing the antenna
Twist the antenna clockwise onto the receiver’s antenna jack.

NOTE: You can also connect an accessory antenna to increase the receiver range. For 
details,  see “Appendix D: Strengthening the Range of the Wireless Signal” on 
page 34.

Turning on the receiver
To turn on the receiver:

1 Connect the cable from the power adapter to the 5V DC port on the bottom panel of the 
receiver. Plug in the power adapter to an outlet or surge protector.

2 OPTIONAL: To view the receiver on a television, connect the included AV cable to the AV OUT 
port on the system. Connect the other end of the cable to the television. For details, see 
“Viewing A/V Output” on page 55.

3 Slide the power switch on the rear panel to the "ON" position.

Tip:
• Place the receiver in a location that will have a clear reception to your camera. Rotate the 

tabletop stand to help position the LCD receiver to your liking.
• Adjust the antenna on the receiver as necessary to provide the clearest reception.

Connect antenna to receiver
8



Installing the camera
Inserting the SD card
The SD card allows you to store video footage captured by the camera.
To insert the SD card:

1 Push the SD card into the SD card slot on the LCD receiver until you hear a "click." The card 
will not be flush when completely inserted.

NOTE: The receiver is compatible with most major brands of SD card up to 16 GB. For 
recording times on SD cards, see “Appendix F: Estimated Recording Times on SD 
Cards” on page 37.

LED Indicators on the LCD Receiver
Use the LED indicators on the LCD receiver to observe the status of the receiver, cameras, 
and SD card.

The blue lights indicate the following:
• NEW: A new video file has been recorded to the SD card
• FULL: The SD card is full

NOTE: NOTE: The "Full" light will only appear if Overwrite is disabled. For details, see 
“Overwrite” on page 25.

• SCAN: Screen Saver Mode ("Scan" Mode) is enabled
• AUTO REC: Motion recording is enabled

NEW AUTO REC LED indicators
9



Using the System
Using the System
By default, the camera included with your system is automatically paired to the wireless 
receiver. The camera and receiver will communicate with each other once they are 
powered on.

Understanding the on-screen display
With camera 1 properly connected and powered on, the system displays a single channel 
full-screen live view of the camera.

NOTE: Power on the cameras before powering on the receiver.

1 File Name: The name of the file actively being recorded. This file will appear in the file list on 
the SD card. The Recording File stamp indicates the hour, minutes, and seconds that the 
system started recording.

1

2

3 4 5 6 7

8

160602-2.AVI
Hour (24-hour)

Minute

Seconds

Camera number

File extension (.AVI)
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Using the System
2 Signal Indicator: The signal indicator shows the strength of the signal being received from 
the camera. The number of bars in the Signal Indicator shows the strength of the signal. One, 
or no bars indicates the signal is poor, and 4 bars indicate a very strong signal. The signal 
indicator is not shown during quad mode.

NOTE: If the signal is low (e.g. 1 or 2 bars) adjust the antennas, or reposition the cameras 
or receiver for best performance.

3 Recording Indicator: "REC" appears during manual, motion, and schedule recording.

4 SD Card icon: A white "SD" icon displays that an SD card is in the wireless receiver. 

5 Power Failure icon: Flashing icon indicates a power failure has occurred on the system. You 
may need to manually restore settings or modes on the system after a power failure. For 
details, see “Appendix G: Power Failure Indicator” on page 38.

6 File Icon: Flashes yellow when writing data to the SD card. Flashes red when the SD card is 
full.

7 Camera indicator: Displays the camera you are presently viewing; position of camera 
indicators shifts to the left side of the screen while in Quad mode.

8 Time Stamp: The current date and time on the system.

About the Status Indicator
The status indicator message "Connecting" 
appears when the receiver is trying to 
locate a camera.

NOTE: There may be temporary signal 
losses for less than 1 second, due to 
the connection retrieval process 
between the Camera and Receiver 
(when switching between channels). 
This is a normal operation of the 
receiver.

SD card fullSD card writing data
11



Using the System
Viewing Modes
There are four different viewing modes available on the system: single channel viewing, 
Auto Sequence Viewing Mode (view individual channels automatically in sequence), Quad 
mode, and Screen Saver Mode.

To change viewing modes:
1 Press the Channel A button on the remote to 

enable Auto Sequence Viewing Mode and 
switch automatically between channels. 

2 Press the Channel M button on the remote to 
disable Auto Sequence.
OR

1 Press the Channel M button on the remote 
repeatedly to switch between channels 1~4

NOTE: By default, Auto Sequence Viewing Mode 
is enabled when you first power on the 
system, and when you exit Screen Saver 
mode.

Quad mode
Use Quad mode to view up to four cameras 
simultaneously.
To enable/disable quad mode:

1 Press the QUAD button on the remote. The Schedule 
Recording warning appears briefly on-screen, then the 
Quad display mode begins.

NOTE: You cannot access the Main Menu or turn on 
Schedule recording while the system is in Quad 
Mode.

NOTE: Quad mode is also available while in Zoom mode. For details on using Zoom, see 
“Zoom” on page 29.

NOTE: Using Quad Mode with Motion Recording is a highly recommended recording 
solution. For more details, see “Motion recording” on page 19.

A= Auto sequence
M = Manual switching

Auto Sequence Example

CH 1 CH 2 CH 4CH 3

CH1 CH2

CH3 CH4

Quad mode
12



Using the System
Screen saver mode
Use the Screen Saver mode to conceal the fact that the LCD receiver is actually a 
surveillance recorder. The system comes pre-loaded with five scenic images that let the 
LCD receiver simulate a picture frame. When motion is detected by a camera, the LCD 
receiver will display the triggered camera in single channel full-screen.

NOTE: The images are loaded to the system firmware, not the SD card. Formatting the SD 
card will not delete the Screen Saver images on the system.

To enable Screen Saver mode:
1 Press the MENU button to open the Main Menu.

2 From the Main Menu, select Setting and press the 
Enter button on the remote.

3 From the Settings menu, select Screen Saver and 
press the Enter button on the remote.

4 From the Screen Saver menu, select Blank screen 
or Picture 1~5 and press the Enter button on the 
remote.

5 Press the MENU button on the remote until all menu windows are closed.

6 Press the Scan/Del button on the remote to activate Screen Saver Mode. One of the selected 
images will appear on the LCD receiver and "SCAN" will light up on the bottom of the LCD 
receiver.

7 Press the Scan/Del button on the remote again to disable Screen Saver mode.

NOTE: The system will be in Auto Sequence mode when Screen Saver mode is disabled.

Scan/Del button
13



Using the System
Motion Detection
With the Screen Saver activated, motion detection is enabled on the system. When motion 
is detected by one of the cameras, the LCD receiver will display the triggered camera in 
single-channel full-screen, and the motion alarm will beep, but the system will not record. 
When the motion trigger is finished, the system will return to Screen Saver mode.

NOTE: Unless the REC stamp appears on-screen, the system is NOT recording. 

Screen Saver with Motion Recording
You can also enable Motion Recording to function with the Screen Saver. 
To enable Screen Saver with Motion Recording:

1 From live viewing, press the Motion button on the remote."AUTO REC" appears on the LCD 
receiver.

2 Press the Scan/Del button to enable the Screen Saver. "SCAN" appears on the LCD receiver.
• When motion is detected by one of the cameras, the system will display the triggered camera 

on-screen, the alarm will beep, and the system will record.
• When motion recording is finished, the system will return to Screen Saver mode.s

NOTE: You can set the length of motion recording from the Record Menu. For details, see 
“Record Time” on page 24.

The Screen Saver displays the triggered camera when motion is detected.
14



Using the System
Setting the time
It is highly recommended to set the time on the 
system prior to recording. You need to set the 
correct date and time in order to use Schedule 
Recording. For more details, see “Motion 
recording” on page 19.
To set the time:

1 From the Main Menu, select Setting and press the 
Enter button on the remote.

2 From the Setting menu, select Date & Time and 
press the Enter button on the remote.

3 Press RIGHT/LEFT to move the cursor; press UP/
DOWN to change the year, month, day, hour, 
minutes, and seconds.

NOTE: The system uses a 24-hour clock.

4 Press Enter on the remote to save your settings.

5 Press MENU on the remote to close any remaining 
menu windows.

NOTE: There no daylight savings time (DST) setting 
on the system. DST must be set manually if 
necessary.

Date & Time menu.

Date and time
15



Recording
Recording
Three recording modes are available on the system: Manual Recording, Schedule 
Recording, and Motion Recording.

NOTE: The system can record video to an SD card one channel at a time.

Prerequisites
1 An SD card must be inserted in the wireless receiver in order to record. You should always 

format the SD card prior to initial recording. For details, see “Format” on page 30.

2 Recording overrides other actions on the receiver. You must stop recording on the system in 
order to perform other actions, such as opening the Main Menu, Quad Mode, etc.

Recording Mode Summary

Mode Description

MANUAL 
RECORDING

• Continuous recording from one camera
• Press the Record button ( ) on the remote control to start/stop 

manual recording
• Cannot record while in Quad mode
• Cannot record while in Auto Sequence Viewing Mode

SCHEDULE 
RECORDING

• Continuous recording from one camera or from Auto Sequence 
Viewing Mode (system will record from one camera at a time)

• ATTENTION: Turn off Manual Recording and Motion Recording 
to enable Schedule Recording

• Enter a Start and Stop Time from Main Menu>Record>Schedule 
Record

• Cannot enable Schedule Recording while in Quad Mode
• Cannot record while in Screen Saver Mode (i.e. if the system is in 

Screen Saver Mode, Schedule Recording will be disabled)

MOTION 
RECORDING (AUTO)

• System only records when motion is detected by a camera
• Compatible with Quad Mode (recommended)
• Compatible with Auto Sequence Viewing Mode
• Press the Motion button on the remote to start/stop Motion 

Recording

SCREEN 
SAVER + 
MOTION 
RECORDING

• Enable Screen Saver for LCD receiver to simulate a picture frame
• Use with Motion Recording:
• Press the Motion button on the remote to start Motion Recording
• Press the Scan/Del button on the remote to enable Screen Saver 

mode
16



Recording
Manual Recording
Manual Recording allows you to 
manually start/stop recording from one 
channel at a time. You cannot record 
while in Quad mode.
You can also record while in Zoom 
mode. For details on using Zoom, see 
“Zoom” on page 29.

NOTE: You cannot change channels or 
enable Auto Sequence Viewing 
Mode during Manual Recording.

To enable Manual recording:
1 Select a channel (1~4) on the wireless 

receiver or from the remote control.

2 Press the Record button ( ) on the remote 
control.
• "REC" appears on screen to indicate the 

system is recording.

3 To stop Manual Recording, press the 
Record button ( ) again. "NEW" will 
appear on the LCD receiver indicating a 
new file is on the SD card.

When Should I Use Manual Recording?
• Emergency recording
• Low traffic environments

Schedule Recording

Use Schedule Recording to have the 
system automatically record 
continuously from a selected camera, 
or from Auto Sequence Viewing Mode 
according to a start and stop time. 

NOTE: You must set a Recording 
Schedule in the main menu in 
order to use Schedule 
Recording.

NOTE: Auto Sequence is available 
during Schedule Recording. 
However, the system will record 
video of the sequence itself. 
Therefore you cannot playback 
video of individual cameras.

Prerequisite:
Please ensure you have set the date and 
time on the receiver prior to setting a 
recording schedule.

Step 1 of 2: Set a recording schedule
1 Press the MENU button on the remote to 

open the Main Menu.

2 Select Record and press the Enter button.

3 Using the remote, press RIGHT/LEFT to 
move the cursor (yellow); press UP/DOWN 
to change the hour and the minutes.

NOTE: You need to press RIGHT to move 
the cursor from Start Time to 
Stop Time.

4 Press the Enter button on the remote to 

save your schedule.

5 Press MENU on the remote until all menu 
windows are closed.
17



Recording
NOTE: You cannot enable Schedule 
Recording if the system is in 
Quad Mode.

Step 2 of 2: Enable schedule recording
1 Disable ALL RECORDING on the system:

• If the system is in Manual Recording, 
press the Record button ( ) on the 
remote.

• If the system is in Motion recording, press 
the Motion button on the remote until the 
blue LED "AUTO REC" does NOT appear 
on the wireless receiver.

2 Select a channel (1~4) from the remote 
control.
OR
Press the CHANNEL A button on the 
remote to enable Auto Sequence 
Viewing Mode.

3 When the Start Time arrives, recording 
begins. The "REC" indicator appears 
on-screen.

Stopping Schedule Recording
When the Stop Time arrives, the system 
stops recording. If necessary, you can 
stop Schedule Recording manually.

To stop Schedule Recording:
1 Press the Record button ( ) on the remote 

control to stop schedule recording.

NOTE: If you stop Schedule Recording, 
you cannot resume Schedule 
Recording. You will need to enter 
new Start and Stop times in the 
Schedule Record menu.

NOTE: "AUTO REC" must not appear on 
the receiver in order for 
Schedule Record to function

When Should I Use Schedule 
Recording?
• It is recommended to use Schedule 

Recording for capturing a sensitive or 
important target that needs to be recorded 
daily, i.e. a cash register, safe, shipping & 
receiving docks, etc.

• During the day in high traffic 
environments

ATTENTION

Manual Recording, Motion 
Recording, Quad Mode, and 
Screen Saver Mode will 
override Schedule Recording. 
 
If you wish to use Schedule 
Recording, you must ensure 
Manual Recording, Motion 
Recording, Quad Mode, and 
Screen Saver Mode are 
disabled.
18



Recording
Motion recording
Use Motion Recording to have the 
system only record when motion is 
detected by one of the cameras. The 
camera that appears on-screen is the 
only camera that is recording.The PIR 
sensor allows the camera to detect 
movement. The maximum range on the 
PIR sensor is 21 feet (6.5 meters).

To enable Motion Recording: 

Prerequisite: Insert an empty SD card 
into the LCD receiver.

1 During live view, press the Motion button 
on the remote control. 
• "AUTO REC" will light up on the LCD 

receiver.

2 Perform one of the following:
• Enable Quad Mode (recommended): 

Press the Quad button on the remote. 
When motion is detected, the system will 
display the triggered camera on-screen. 
When motion recording is complete, the 
view will return to Quad Mode.

• Enable Auto Sequence Viewing Mode: 
Press the CHANNEL-A button on the 

remote. When motion is detected, the 
system will display the triggered camera 
on-screen. When motion recording is over, 
Auto Sequence Viewing Mode will continue 
as normal.

• Change channels manually: Press the 
CHANNEL-M button on the wireless 
receiver or remote control to select a 
channel.

3 Press the Motion button on the remote 
again to stop Motion Recording. "AUTO 
REC" will turn off on the receiver.

• The "REC" indicator will only appear when 
motion is detected by one of the cameras 
on-screen.

• By default, the system is set to record for 
15 seconds after the triggered motion 
event. For details on adjusting the motion 
recording time, see “Record Time” on 
page 24.

Recording Tip:
If you are using more than one camera, 
it is highly recommended to use Quad 
Mode with Motion Recording. Quad 
Mode allows you to see all four cameras 
at once. When motion is detected, the 
triggered camera will appear 
on-screen. After motion recording is 
complete, the receiver will return to 
Quad Mode.

A camera detects movement, and triggers the system to 
record.

If you manually select a channel while 
the system is in Motion Recording 
Mode, motion recording will ONLY 
apply to the selected channel. For 
example, with Motion Recording 
enabled, you manually select channel 
3; if motion were to occur in view of 
camera 1, the system would NOT 
RECORD video from channel 1.

ATTENTION
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Recording
Viewing Recorded Video
With video recorded on the SD card, you 
can open the File menu to playback the 
video files.

You can playback recorded video on the 
system (when connected to a TV or 
monitor) or directly from the SD card - 
simply connect the SD card to your 
computer. 

Viewing Video Using the System

To playback recorded video on the 
system:

1 Stop all recording on the system.

2 Press the Enter button on the remote. The 
File menu opens.

3 Select the VIDEO folder and press Enter 
button on the remote.

4 Select a folder and press the Enter button 
on the remote. Folders are labeled by date 
(yymmdd): e.g. 080512. Select [. .] and 
press the Enter button on the remote to go 
up a level.

5 Select a file from the list and press the 
Enter button on the remote. The selected 
file loads and playback begins.

Tip:
Press LEFT and RIGHT to change pages 
to find video files quickly.

Controlling Playback
Once the file begins playing, use the 
buttons on the remote control or 
wireless receiver to control playback.

To control playback:
• �: Play/Pause playback; restart video 

from the beginning.
• � : Fast forward playback 2X, 4X, 8X, 16X, 

32X, and 64X. During fast-forward, press 
�to pause and then press �again to 

play
• : Stop playback.
• �:Rewind playback 1X, 2X, 4X, or 8X. 

During rewind, press �to pause, then 
press �again to play.

• Volume + / - : Press to increase/decrease 
volume during playback.

• Press the MENU button to return to the 
file list

All recording must be stopped on 
the system prior to playing back 
saved video files. 

ATTENTION

�

�

+/-
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Recording
Viewing Video Directly From the 
SD Card
You can view the saved video files on 
your computer (PC or Mac) by using an 
SD card reader (not included). Saved 
video files are in AVI format.

NOTE: Some PCs and Macs may have 
an SD card reader built-in. 
Please refer to your computer's 
instruction manual for more 
details.

PC

To playback recorded video on a PC:
1 Remove the SD card from the wireless 

receiver by gently pushing on the SD card. 
The SD card will pop out from the slot.

2 Insert the SD card into an SD card reader 
(not included) connected to your PC. Your 
PC should load the SD card as a new 
Removable Drive.

3 View files and folders on the SD card. You 
should see a folder labeled "VIDEO."

4 Open the VIDEO folder and then open one 
of the Date folders (yymmdd). The AVI file 
list appears.

5 Double-click any of the AVI files. The video 
will begin playing in your default AVI media 
player.

MAC

To playback recorded video on a Mac:
1 Remove the SD card from the wireless 

receiver by gently pushing on the SD card. 
The SD card will pop out from the slot.

2 Insert the SD card into an SD card reader 
(not included) connected to your Mac. Your 
Mac should load the SD card as a new Disk 
Image.

3 View files and folders on the SD card. You 
should see a folder labeled "VIDEO."

4 Open the VIDEO folder and then open one 
of the Date folders (yymmdd). The AVI file 
list appears.

5 Double-click any of the AVI files. The video 
will begin playing in your default AVI media 
player.

For details on deleting files on the 
system, see “Appendix E: Deleting Video 
Files on the System” on page 36.

The XviD, DivX, or FFDShow codec is required if 
attempting to view the video files in Windows 
Media Player™. You can also view AVI files natively 
in other media players such as VLC and DivX 
Player.

ATTENTION

Additional codecs are required if attempting to 
view AVI files in QuickTime. VLC Player is 
recommended for viewing AVI files on a Mac. VLC 
is an open-source freeware application available 
at www.videolan.org

ATTENTION
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Recording
Using the Intercom
Use the Intercom feature for two-way 
communication between the LCD 
receiver and the camera. Talk the 
person at the camera from behind 
closed doors for added security.

NOTE: Please make sure the camera(s) 
is properly connected prior to 
using the Intercom.

To use the Intercom:
1 Press and hold the TALK button on the 

back of the LCD receiver. An audio icon 
appears on-screen.

2 Talk in a normal speaking voice close to 
the LCD screen (approximately 12 in. / 30 
cm).

3 Release the TALK button to hear a 
response from the camera(s).

Two-Way Audio Volume
The two-way audio volume is different 
from the alarm/buzzer volume found in 
the Main Menu (Main 
Menu>Settings>Alarm Volume). Use 
the volume buttons on the remote 
control to change the volume for 
two-way audio.

To change two-way audio volume:
1 From live viewing, press the Vol+ button to 

increase system volume.

2 Press the Vol- button to decrease system 
volume.
Use the white volume icons on the 
on-screen display to help you set the 
volume for two-way audio.

Talk button

2-way audio volume
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Using the Main Menu
Use the Main Menu to configure camera 
and receiver settings.

To open the Main Menu:
• Press the MENU button on the wireless 

receiver or the remote control

NOTE: Make sure the display is in single 
channel full-screen view prior to 
opening the Main Menu

NOTE: If a power failure occurs on your 
system, you may need to 
re-configure your settings. For 
more details, see “Appendix G: 
Power Failure Indicator” on 
page 38.

Camera On/Off
Use the Camera On/Off menu to show/
hide camera channels on the main 
display screen. For example, if you 
disable camera 3, it will not appear in 
single channel full-screen, or in Quad 
mode.

NOTE: Make sure cameras are properly 
connected and paired to the 
receiver before disabling.

To enable/disable cameras:
1 From the Main Menu, select Camera On/

Off and press the Enter button on the 
remote.

2 Select the desired camera and press 
RIGHT/LEFT to select On or Off.

NOTE: The currently selected camera 
will have On/Off highlighted in 
RED.

3 Press the Enter button on the remote.

4 Press the MENU button on the remote to 
exit.

NOTE: Any disabled channels will be 
blacked out in Quad mode.

Record
Use the Record menu to change image 
quality, motion recording time, set a 
recording schedule, and enable/disable 
overwrite.

The Record menu contains the 
following sub-menus:
• Quality: Set the image resolution to 

320x240 (QVGA) or 640x480 (VGA)
• Record Time: Set the recording time when 

motion is detected by a camera
• Schedule Record: Set start and stop times 

for automatic recording
• Overwrite: Enable/disable overwrite of 

the SD card
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Quality

To change the image quality:
1 From the Main Menu, select Record and 

press the Enter button on the remote.

2 From the record menu, select Quality and 
press the Enter button on the remote.

3 Press LEFT/RIGHT to select 320x480 
(QVGA) or 640x480 (VGA).

4 Press the Enter button on the remote to 
save your settings.

5 Press the MENU button on the remote 
until all menu windows are closed.

Record Time
Use the Record Time menu to set the 
length of the time for the system to 
record after motion is detected by a 
camera.

To change the motion recording time:
1 From the Main Menu select Record and 

press the Enter button on the remote.

2 From the Record menu select Trigger 
Record and press the Enter button on the 
remote.

3 Select 5 seconds, 15 Seconds, or 30 
Seconds and press the Enter button.

4 Press the MENU button until all menu 
windows are closed.

Schedule Record
Use the Schedule Record menu to set 
start and stop times for Schedule 
Recording. During this time block, the 
system will record continuously from 
one specific camera, or from any 
cameras in Auto Sequence Viewing 
Mode.

NOTE: The time uses the 24-hour clock.

To set a recording schedule:
1 From the Main Menu, select Record and 

press the Enter button.

2 From the Record menu, select Schedule 
Record and press the Enter button.

3 Press RIGHT/LEFT to move the cursor 
(yellow); press UP/DOWN to change the 
hour and the minutes.
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NOTE: You need to press RIGHT to move 
the cursor from Start Time to 
Stop Time.

4 Press the Enter button on the remote to 
save your schedule.

5 Press the MENU button on the remote 
until all menu windows are closed.

6 Disable Manual and Motion Recording on 
the system.

NOTE: Motion Recording will override 
schedule recording. For details, 
see “Schedule Recording” on 
page 17.

NOTE: You cannot enable Schedule 
Recording if the system is in 
Quad Mode. For details, see 
“Quad mode” on page 12.

Overwrite
Use the overwrite feature to have the 
system overwrite the oldest recorded 
data on the SD card once the SD card is 
full.

To enable overwrite:
1 From the Main Menu select Record and 

press the Enter button on the remote.

2 From the record Menu select Overwrite 
and press the Enter button on the remote.

3 Select Yes and press the Enter button on 
the remote.

4 Press the Menu button until all menu 
windows are closed.

NOTE: If you do not enable Overwrite, 
the system will prompt you when 
the SD card is full by two ways: 
the SD Card icon on the OSD will 
be solid blue and a blue LED will 
light up under "FULL" on the 
wireless receiver. You will need 
to manually delete files from the 
SD card or insert a new SD card 
into the wireless receiver. For 
details see “Appendix E: 
Deleting Video Files on the 
System” on page 36.

Pairing
Use the Pairing menu to pair additional 
cameras (up to 4) to the system. By 
default, the camera included with your 
system is automatically paired to 
channel 1 on the wireless receiver. The 
second camera is paired to channel 2 
and so forth. 

What is pairing?
"Pairing" is an electronic handshake 
between wireless devices. Wireless 
devices and components need to be 
paired in order to communicate with 
each other.

To pair an additional camera:
1 Connect the camera to a power outlet. 

Place the camera and LCD receiver within 
1 ft of each other.
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2 Press MENU on the wireless receiver or 
remote control.

3 From the Main Menu, select Pairing and 
press the Enter button on the remote.

4 Select Camera 2, Camera 3, or Camera 4 
and press the Enter button on the remote.

NOTE: By default, the camera included 
with your system is paired as 
Camera 1 (channel 1).

5 Following the on-screen prompt, press the 
Pair button on the rear panel of the 
camera. You have 30 seconds to press the 
PAIR button on the camera. Once paired, 
the camera will be immediately displayed 
on-screen.

NOTE: If you do press the Pair button 
on the camera during the 30 
second pairing window, repeat 
steps 2~5 to try the pairing 
process again.

Settings
Use the Settings menu to set the system 
time, change display options, and 
format the SD card.

The Settings menu contains the 
following sub-menus:
• Date & Time: Set the date and time on the 

system
• Brightness: Adjust screen brightness 

level
• AV Out: Select the TV system for audio/

video output
• Screen saver: Select an image for Screen 

Saver mode
• Alarm Volume: Increase/decrease the 

system volume
• Zoom: Set 1X or 2X digital zoom on 

cameras
• Format Memory: Format the SD card
• Factory Reset: Restore the system to 

factory settings
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Date & Time
Use the Date & Time menu to set the 
time and date on the system. You must 
set the date and time in order to use 
Schedule Recording. For details, see 
see “Schedule Recording” on page 17.

To set the date and time:
1 From the Main Menu, select Setting and 

press the Enter button on the remote.

2 From the Setting menu, select Date & 
Time and press the Enter button on the 
remote.

3 Press RIGHT/LEFT to move the cursor; 
press UP/DOWN to change the year, 
month, day, hour, minutes, and seconds.

NOTE: NOTE: The system uses a 
24-hour clock.

4 Press the Enter button on the remote to 
save your settings.

5 Press the MENU button on the remote 
until all menu windows are closed.

Brightness
Use the Brightness menu to adjust the 
brightness level of the LCD screen.

To adjust brightness:
1 From the Main Menu, select Setting and 

press the Enter button on the remote.

2 From the Settings menu, select 
Brightness and press the Enter button on 
the remote.

3 Press LEFT/RIGHT to increase and 
decrease the brightness.

4 Press the Enter button on the remote to 
save your settings.

5 Press the MENU button on the remote 
until all menu windows are closed.
27



Using the Main Menu
AV Out
Use the AV out menu to select the TV 
system for the wireless receiver. 

To select the TV system:
1 From the Main Menu, select Setting and 

press the Enter button on the remote.

2 From the Settings menu, select AV out and 
press the Enter button on the remote.

3 Select NTSC (North America) or PAL (UK/
Europe) and press the Enter button on the 
remote.

4 Press the MENU button on the remote 
until all menu windows are closed.

Screen Saver
Use the Screen Saver menu to select an 
image for Screen Saver mode.

To configure the screen saver:
1 From the Main Menu, select Setting and 

press the Enter button on the remote.

2 From the Settings menu, select Screen 
Saver and press the Enter button on the 
remote.

3 From the Screen Saver menu, select None 
(black) or Picture 1~5 and press the Enter 
button on the remote.

4 Press the MENU button on the remote 
until all menu windows are closed.

To enable Screen Saver mode:
1 Press the Scan/Del button on the remote. 

The selected image appears on the LCD 
screen.

2 Press the Scan/Del button on the remote 
again to disable the Screen Saver and 
return to live viewing.

Alarm Volume
Use the Alarm Volume menu to 
increase / decrease the volume of the 
buzzer when motion is detected by the 
camera(s). The Alarm Volume also 
affects the volume of the "beep" that is 
heard when you press a button on the 
remote control.
• If using AV out, changing the system alarm 

volume will also affect the level of audio 
output.

To increase/decrease alarm volume:
1 From the Main Menu, select Setting and 

press the Enter button.
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2 From the Settings menu, select Alarm 
Volume and press the Enter button on the 
remote.

3 Press RIGHT to increase the alarm 
volume, and press LEFT to decrease the 
alarm volume.

4 Press the Enter button on the remote to 
save your settings.

5 Press the MENU button on the remote 
until all menu windows are closed.

Zoom
Use the zoom menu to enable 1X and 2X 
digital zoom on the cameras. While 
zoomed in, you can scan the image and 
view channels in full-screen.

NOTE: Zoom is intended as a temporary 
setting that is applied to ALL 
CHANNELS. When you are 
finished using zoom, you should 
return the view to 1X view.

To set the zoom:
1 View camera 1, 2, 3 or 4 in single-channel 

full-screen.

2 From the Main Menu, select Setting and 
press the Enter button on the remote.

3 From the Settings menu, select Zoom and 
press the Enter button on the remote.

4 Select X 1 or X 2 and press the Enter 
button on the remote.

5 Press the MENU button until all menu 
windows are closed. The selected camera 
will be shown on the main display in 2X 
zoom.

While zoomed in you can perform the 
following:
• Press LEFT/RIGHT/UP/DOWN to scan the 

image.
• Press the CHANNEL-M button on the 

remote to change channels manually (you 
can only change channels using the 
CHANNEL-M button while zoomed in)

• Press CHANNEL-A to enable Auto 
Sequence

• Press the Record button ( ) to start/stop 
manual recording

• Press the Quad button on the remote to 
view Quad mode - all channels will be 
zoomed-in

To disable zoom:
1 Open the Zoom menu.

2 Select X 1 and press the Enter button on 
the remote.

3 Press the MENU button on the remote 
until all menu windows are closed.
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Format
Use the Format menu to format the SD 
card. It is highly recommended to 
format the SD card prior to initial 
recording.

To format the SD card:
1 Insert the SD card into the SD card slot on 

the wireless receiver until you hear a 
"click." Please insert the card according to 
the diagram on the panel.

2 From the Main Menu, select Setting and 
press the Enter button on the remote.

3 From the Settings menu, select Format 
and press the Enter button on the remote.

4 Select Yes and press the Enter button on 
the remote. Please allow a few moments 
for formatting to finish. Formatting time 
will vary depending on the size of the SD 
card.

Factory Reset
Use the Factory Reset menu to restore 
the system to factory settings.

NOTE: Restore factory settings DOES 
NOT delete video files on the SD 
card, nor does it reset the date 
and time on the system.

To restore factory settings:
1 From the Main Menu, select Setting and 

press the Enter button on the remote.

2 From the Settings menu, select Factory 
Reset and press the Enter button on the 
remote.

3 Select Yes and press the Enter button on 
the remote.

4 Press the MENU button on the remote 
until all menu windows are closed. 

Formatting erases all data on 
the SD card. This step cannot 
be undone.

ATTENTION
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Appendix A: System Specifications

General

Camera

LCD Receiver

Description Specification
Transmission Frequency ISM 2,400~2,483.5 MHz
Transmission Power 14dBm
Unobstructed Effective Range 450ft / 150 m (line of sight)
Spread Spectrum FHSS
Modulation Mode GFSK
Operating Temperature 14 ~ 122° Fahrenheit / -10 ~ +50° Celsius
Operating Humidity < 85%

Description Specification
Image Sensor CMOS
Total Picture Pixels 640 x 480pxl (NTSC)
Minimum Illumination 0Lux (IR on)
Night Vision Distance 40 FT
PIR Range 21 FT 
View Angle Diagonal 52°
Power Consumption (Max.) Max 350mA
Power Supply 9V DC
Dimensions W: 75mm, L: 110mm, H: 190mm

Weight 0.60 lbs / 0.27 kg

Description Specification
Display 9" diagonal or 7‘diagonal (check package for display size)
Supported Resolution 640 x 480 @ 10fps or 320 x 240 @ 25fps
Receiving Sensitivity -81dBm
Power Consumption (Max.) 850mA
Power Supply 5V DC
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Appendix B: About Digital Wireless Technology
The Digital Wireless signal transmission type used by receiver is also known as FHSS 
-Frequency Hopping Spread Spectrum. This type of signal is highly resistant to deliberate 
jamming as it generates a channel hopping sequence using an algorithm generated by the 
receiver system.

The 2.4GHz (2.400-2.480Ghz) band is being divided into sections or paths of 2MHz per 
section, and each second the transmission signal hops hundreds of times in a specified 
sequence within this frequency range. The overall bandwidth required for frequency 
hopping is much wider then 2MHz however because transmission occurs only on a small 
section of this bandwidth at any given time, the signal being transmitted does not suffer 
from greatly reduced signal degradation and also avoids blocked paths other devices who 
act as sources of competing signals. The strength of the signal being transmitted is set to 
be from 13.5-16dBm, which is much higher then the analog transmission signal allowed by 
authorities around the Globe.

When an image is captured by the camera it is instantly converted from an analog to digital 
signal and packaged into small packets. With each successful transmission via the 2 MHz 
paths discussed above, the packets of information containing images are delivered to the 
receiver and decoded into analog information. The information can then be displayed on 
devices that are connected to the wireless receiver (RX).

A device pairing process is required to synchronize the transmitter (TX, Camera) and the 
receiver (RX). This allows the transmitter and receiver to be on the same frequency and use 
the same algorithm for frequency hopping. This ensures that only the paired transmitter 
and receiver can maintain communication signal by hopping to the same frequency paths 
at the exact same time. As a result, the chance that other devices within the same 
frequency range are on the same frequency, at the same time and in the same order is 
extremely unlikely.  Note that the pairing process is already done at the factory for 
products that ship within the same packaging. Only when add-on devices are purchased is 
a pairing process required.
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Appendix C: Adding Cameras
The system comes with camera(s) that have already been paired to the LCD receiver. The 
Pairing Function assigns each camera to a different channel on the wireless receiver (up 
to four (4) cameras), and is necessary for configuring additional cameras. 

NOTE: To order additional cameras, order part number LW2711AC1.

By default, the camera included with your system is automatically paired to channel 1 on 
the wireless receiver. The second camera is paired to channel 2 and so forth.  See channel 
label on the bottom of the camera to check which channel it has been set to .

It is highly recommended to pair the cameras to the receiver before permanently 
mounting the cameras.

To pair an additional camera:
1 Connect the new camera to a power outlet. Place the 

camera and LCD receiver within 1 ft of each other.

2 Press MENU on the wireless receiver or remote control.

3 From the Main Menu, select Pairing and press the Enter 
button on the remote.

4 Select a channel and press the Enter button on the 
remote.

NOTE: If you pair a new camera to a channel which is already 
being used by an existing camera, the new camera will be connected to that channel. 
The old camera will automatically be disconnected.

5 Following the on-screen prompt, press the Pair button behind the camera. You have 30 
seconds to press the Pair button on the camera. Once paired, the camera will be immediately 
displayed on-screen.

NOTE: If you do press the Pair button on the camera during the 30 second pairing window, 
repeat steps 2~5 to try the pairing process again.

Pair button
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Appendix D: Strengthening the Range of the Wireless Signal
DISCLAIMER: Certain accessories are not available in all markets.

There are several ways to boost your wireless signal as well as options to help you extend 
the range of the wireless signal.

Clear Line-of-Sight
The digital wireless signal is virtually interference free. However, you should always 
ensure there is a clear line-of-sight between the camera and the receiver.

Obstacles
There should be little to no obstacles obstructing the line-of-sight between the camera and 
the receiver. Solid objects, such as concrete and metal may limit the range of the wireless 
signal.

Extending Your Wireless Signal
Even with a clear line-of-sight between your camera(s) and your receiver, you may 
experience a lower video frame rate simply due to the distance between your wireless 
devices.
Accessory antennas are available that can help extend the range of your wireless signal.

Clear line of sight

Clear line of sight

Cable accessory antenna
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2.4 GHZ Directional Wireless Panel Antenna
Use the 2.4GHz Directional Wireless Panel Antenna (model 
#: ACCANTD9) to focus a wireless signal onto one specific 
camera in order to increase range of transmission (clear 
line-of-sight between the camera and the antenna is 
required). A 20 ft. extension cable is included help with 
proper position of the antenna.

2.4 GHZ Omni-Directional Wireless Antenna
Use the 2.4GHz Omni-Directional Wireless Antenna (model #: ACCANTO9) to extend the 
range and boost the signal of several wireless cameras. You should position the 
Omni-Directional  Wireless Antenna in an elevated position to provide a clear line-of-sight 
to the cameras. A 20 ft. extension cable is included help with proper position of the 
antenna.

Visit www.lorextechnology.com for more details on wireless antennas and accessories.

Directional Wireless Panel Antenna
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Appendix E: Deleting Video Files on the System
You can delete video files on the SD card directly on the system. Deleting files if you need 
to clear space on the SD card (if Overwrite is disabled), or for your own file management 
purposes. For details, see “Overwrite” on page 25.

To delete files on the SD card:
1 From live viewing, press the Enter button on the remote. The File menu opens.

2 Select the VIDEO folder and press the Enter button on the remote.

3 Select a Date folder and press the Enter button on the remote. The file list opens.

4 Select a file and press the Scan/Del button on the remote.

5 At the prompt, select YES and press the Enter button on the remote. The file is deleted and 
the File List returns as normal.

6 Repeat steps 3~5 for other files on the SD card.
NOTE: You cannot delete folders on the SD card using the system.

091252_1

091252_1

100341_3

Del 092532_4?
YES NO 

980KB

8112KB
2MB

Use caution if attempting to delete folders on the SD card 
using your computer. Deleting folders may affect your access 
to other files on the card or may affect normal operation of 
the SD card with the system. If you want to delete the contents 
of the SD card, it is highly recommended to format the card 
using the system. For details, see “Format” on page 30.

ATTENTION
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Appendix F: Estimated Recording Times on SD Cards
Use the table below to help you estimate the recording times on various sizes of SD cards. 
Times shown are in hours, minutes, and seconds.

NOTE: The system is compatible with SD High Capacity (SDHC) cards, minimum Class 2. 
Using higher class SD memory does not ensure better performance.

SD Card 
Capacity QVGA 320x240 VGA 640x480

512 MB 1:20:22 O:54:18
1 GB 2:32:05 1:46:24
2 GB 5:02:47 3:47:17
4 GB 10:15:24 7:02:13
8 GB 17:58:28 14:05:01
16 GB 34:54:25 28:10:35

Standing Recording Time
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Appendix G: Power Failure Indicator
A power failure may interrupt recording modes on the system. After power is restored, the 
following will occur:
• The system will restart in Auto Sequence Mode + Motion Recording - this ensures that some 

form of recording will be immediately active on the system.

NOTE: If you had a different display view or recording mode set when the power failure 
occurred, you will need to re-apply the previous display view and recording mode. 

• A flashing Power Failure icon ( ) appears on-screen. The Power Failure icon indicates 
that a power failure occurred while the system was actively recording (i.e. "REC" icon was 
on-screen)

NOTE: The flashing icon appears only if the system was actively recording when the power 
failure occurred. The flashing icon will disappear when you press buttons on the 
receiver or remote control.

Power Failure icon
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Appendix H: Viewing your camera remotely using Skype
Connecting to your video monitor through Skype is a convenient and free* method to view 
your camera from anywhere with an internet connection.

NOTE: When remotely connecting to your video monitor using Skype, recording is disabled.

Requirements

iPhone, iPad, iPod Touch Requirements
• Skype for iPhone 3.0 and above
• iPhone 4 / 3GS (iOS 4.0 and above)
• 3rd generation iPod touch
• iPad

For the latest device compatibility list, visit 
www.lorextechnology.com

PC Requirements
• Skype for Windows version 4.2 and above
• Windows 7/Vista/XP SP2
• 1 Ghz or greater processor

High speed internet connection
You must have a high-speed internet 
connection to use the video function on 
Skype. Video quality depends on bandwidth 
and network traffic. Traffic congestion may 
result in choppy video.

Skype server

How it works
Your computer connects to the Skype server. The Skype server is 
connected to your home computer. Your home computer connects to 
the video monitor, which captures video from the camera.

Home computer

Disclaimers
Mobile Data Charges
When using a mobile cellular 
network, data charges may apply. 
Check with your provider for 
details. 

*Computer to computer

For Skype related support, visit 
https://support.skype.com/ 
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Connecting to Skype on a PC

Step 1 of 5: Installing the camera driver
You will need to install the camera drivers located on the software CD (included).

To install the camera drivers:
1 Insert the software CD into the computer. An autoplay window opens.

2 Click Run Lorex.exe.

3 Click the USB Driver button, then click USB Driver. The driver will appear on your desktop.

4 Click the X button ( ) to close the window.

Run Lorex.exe

1. Click the USB Driver button

2. Click "USB Driver" to copy the 
driver to your desktop.

X button
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5 Double-click the Usbdriver icon ( ) on your desktop.

6 Follow the on-screen instructions to complete the driver installation.

Step 2 of 5: Connecting the video monitor to the PC

1 Turn on the camera first, then the video monitor. Make sure you can see a video image on 
channel 1. 

NOTE: Pair the camera that is most important for you to view remotely, to Channel 1. 

2 Connect the USB cable (included) to your video monitor and into the computer’s USB port. 
The video monitor displays the following: "USB PC CAMERA MODE"

USB cable

USB Port
41



Appendix H: Viewing your camera remotely using Skype
Step 3 of 5: Creating a Skype account
A Skype account allows you to connect to your camera through the Skype service. Skype is 
a service that allows users to make voice calls and video calls to anywhere in the world. 

In order to connect to your video monitor using Skype, you will need two accounts---one 
for the camera (i.e. Lorex Camera) and one for yourself (i.e. Tom Smith).

NOTE: The Skype illustrations and instructions below serve as a guideline only. Skype may 
change their website / product interface without prior notice.

If you do not have a Skype account
See “If you do not have a Skype account” on page 47.

If you have an existing Skype account
You will have to create a separate account for your camera. Follow the instructions below.

1 Launch Skype. If you are connected to Skype, click Skype>Sign Out.

2 From the Skype Login window, click Don’t have a Skype name?

3 Follow the on-screen instructions to create a new camera account (i.e. Lorex Camera) or an 
account for yourself (i.e. Tom Smith).

Click "Don’t have a Skype name?"
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Appendix H: Viewing your camera remotely using Skype
4 Upon login, click the See my video button to confirm that Skype detects the camera.

5 Click the Close button to exit.

NOTE: If you do not see the "See my video" button, click Tools>Options>Video Settings. 
Make sure you can see video in the window. Click Save to exit.

See my video

Live video

Close button

Video Settings button
Live video

Save button
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Appendix H: Viewing your camera remotely using Skype
6 Click on Tools>Options.

7 Click the Calls button ( ).

8 Click the Show advanced options button.

9 Select the "Answer incoming calls automatically" checkbox and the "Start my video 
automatically when I am in a call" check box. Click Save.

Options

Show advanced options

Save
44



Appendix H: Viewing your camera remotely using Skype
Step 4 of 5: Send a contact request
Next, you have to send a friend request to your personal account (i.e. Tom Smith).

1 Click the Add a contact button ( ).

2 Search for the name of your personal account (i.e. Tom Smith), and then click the Add button.

3 Click Send Request.

Add a contact
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Step 5 of 5: Test the connection

NOTE: This step requires you to log in to Skype from a different computer or compatible 
mobile device. 

1 Log in to your personal account (i.e Tom Smith).

2 A "new contact" pop-up appears. Click the new contact request icon that appears on the 
bottom-right corner of the window.

3 Click the Add to Contacts button to add the camera to your contact list.

4 From the contact list, right-click on your camera’s account name (i.e. Lorex Camera), and 
click Call.
• The video call begins automatically.
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If you do not have a Skype account
Create your personal account first (i.e. Tom Smith), then create a second account for your 
camera (i.e. Lorex Camera). 

Create a personal account (i.e. Tom Smith):
1 Go to www.skype.com, and click on Join Skype.

2 Click Create Account. Fill in the appropriate fields. 

3 Click the I Agree - Continue button.

4 Follow the on-screen instructions to download and install Skype on your computer.

5 Once you are logged in to Skype, click on Skype>Sign out, then see “If you have an existing 
Skype account” on page 42 .

Join Skype

Create Account

I Agree - Continue
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For your convenience, write down your Skype information:

Changing the camera view on Skype

NOTE: This section is applicable only if you have more than 1 camera.

Pair the camera that is most important for you to view remotely, to Channel 1. When you 
connect the USB cable to the video monitor, the video monitor defaults to Camera 1, even 
if you have a different channel selected.

NOTE: You can only view one camera at a time

NOTE: Viewing through Skype does not allow you to change channels remotely, however, 
you can change the channel manually by using the video monitor (see below for 
details). 

To change the camera view:
• From your video monitor, press right on the joystick to change the camera number.
• The camera number changes from "CAM 1" to "CAM 2". 

"Personal" Skype account 
(i.e. Tom Smith)

"Camera" Skype account  
(i.e. Lorex Camera)

Skype Name:

Password:

Email address used to register this 
account (used for account retrieval):

Skype Name:

Password:

Email address used to register this 
account (used for account retrieval):

Joystick
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Viewing a camera on your mobile device
You can remotely monitor your camera on Skype on supported mobile devices. 

Supported Devices 
• iPhone 4/ 3GS (iOS 4.0 and above)
• iPod touch (3rd generation and above)
• iPad (iOS 4.0 and above)

For an updated list, visit www.lorextechnology.com and visit the product page.

Prerequisites
• Create and configure the PC Skype software. For details, see “Appendix H: Viewing your 

camera remotely using Skype” on page 39.
• Ensure you configure your camera’s Skype account to auto-accept incoming calls. For details 

see step 6~9 on page 44.

To view your camera on a mobile device:
1 Download and install the mobile Skype application from the mobile application store (i.e. App 

Store for the iPhone).

2 Launch Skype and tap Contacts.

NOTE: The video monitor’s account may be under "All Contacts".

3 Select the video monitor’s account, and tap Video Call to connect to the camera.

Video Call button

iPhone / iPad screenshot shown.
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Troubleshooting
Troubleshooting

Problem Solution
There is no picture from a Camera. • Check power to the Camera. Make sure the adapter is plugged in and 

the red LED light on the power adapter is on
• Make sure that the Cameras and Receiver are both ON.
• Make sure that the camera is in range of the Receiver.

There is Interference with the 
Camera Picture.

• Make sure that each camera is within range, and that there are no 
large obstructions or interference

• Try repositioning the camera, receiver or both to improve the 
reception.

The picture is dropping • Move the camera closer to the receiver.
• Try repositioning the camera, receiver or both to improve the reception

The Picture is or has become  Choppy • The picture may become choppy when experiencing a lower frame 
rate (i.e. 10 frames per second vs. a higher 20 frames per second). 

• Try moving the camera closer to the receiver. 
• Remove obstructions between the Receiver and Camera
• Try switching to QVGA mode. Resolution will be reduced but video 

frame rate will increase

The Picture appears to be grainy/
distorted

• When using with large screen TV/Monitor (especially high-definition 
televisions), the picture might be grainy as the camera limits video 
resolution to VGA (640x480 pixels). This is not a product defect. 

• For best performance use with TV/Monitor PIP (Picture in Picture) 
function. Check your TV/Monitor product manual to see if this feature 
is available on your TV/Monitor

• View video on a smaller screen TV/Monitor
• Consider increasing the range of the wireless signal with an accessory 

antenna (page 34)
The Picture is white • Common situation know as "washout" or "whitewash" where a strong 

light source is pointed at the camera lens. The camera lens IS NOT 
harmed during a whitewash.

• DO NOT point your camera towards a light source
"Er" appears on the on-screen 
display

• The system has encountered an error with the SD card. Power off the 
receiver, remove then re-insert the SD card, and then power the 
receiver back on

• If "Er" still appears on the OSD, format the SD card
The buttons on the receiver don't 
work

• The Lock may be engaged. On the right panel of the receiver, slide the 
lock away from the SD card slot

• If the lock is disengaged but the buttons still do not function, power 
the receiver off then power it back on

The 1, 2, 3, & 4 buttons do not change 
channels

• The 1, 2, 3, and 4 buttons jump to their respective channels while in 
Quad Mode; press the CHANNEL-M button on the remote control or 
the receiver to change channels manually
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Frequently Asked Questions

General Questions
Q: Why can't I open the main menu, change viewing mode, access recordings, or access 
any other options while in recording mode?
A: In order to perform any changes on the system while in recording mode, you will need 
to stop recording. Recording overrides other actions on the receiver.

Q: How do I turn off the Alarm ('beeping') sound?
A:

1 Press the Menu button on the remote.

2 Navigate to Setting>Alarm Volume

3 Press the back (number 4) button repeatedly on the remote to turn the volume all the way 
down. Note: One volume bar means the alarm sound is muted.

4 Press Enter on the remote.

Q: Can I extend the wireless range of the receiver?
A: Yes. There are optional antennas available at lorextechnology.com that help boost 
wireless signals.

Q: While in Quad Viewing mode, how can I quickly go to a specific channel?
A: Press the direction button on the remote that refers to the channel number you want to 
view.
To now view another channel, repeatedly press the M channel button on the remote until 
you have reached your desired channel.

Q: What happens to the system during a power failure while in recording mode?
A: A power failure may interrupt recording modes on the system. After power is restored, 
the following occurs:
• The system will restart in Auto Sequence Mode + Motion Recording. This ensures that some 

form of recording will be immediately active on the system.
• A flashing Power Failure icon will appear on-screen. The Power Failure icon indicates that a
power failure occurred while the system was actively recording.

NOTE: If you had a different display view or recording mode set when the power failure
occurred, you will need to re-apply the previous display view and recording mode.
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Frequently Asked Questions
NOTE: The flashing icon appears ONLY if the system was actively recording when the power 
failure occurred. The flashing icon will disappear when you press buttons on the 
receiver or remote. 

NOTE: If a power failure occurs during recording, you may lose video recorded within ten 
minutes of occurrence of the power failure if set to Manual or Scheduled Recording 

Q: What is the maximum distance I can have between the camera and the receiver?
A: Typically 450 feet (137 m) with a clear line of sight in open space, or approximately 150 
feet(46 m) in a house. Walls, studs, furniture will interfere with the range of wireless 
transmission. Try repositioning the camera and/or monitor to achieve optimal signal 
strength. An optional antenna (available at lorextechnology.com) may help extend the 
range and/or get around obstacles.

Q: What does 'line-of-sight' mean?
A: 'Line-of-sight' means that there are no obstructions which may interfere with the 
transmission of the audio/video signal. Obstructions include items such as walls, buildings 
and certain electronic devices.

Q: Why does my "wireless camera" have a power cable?
A: The term "wireless" refers to the lack of a video cable between the camera and the 
receiver. The camera still requires a power source.

Q: What is pairing?
A: Pairing is an electronic handshake between digital wireless devices. Pairing allows the 
devices to communicate exclusively with each other. The transmission is secure.

Q: Can digital wireless cameras be paired to more than one receiver?
A: Digital Wireless cameras can only be paired to one receiver. This is to prevent 
interception by 3rd parties, and prevents any other device from picking up the signal - this 
also means that you cannot pair one camera to multiple receivers.

Q: What does the flashing power-plug icon mean?
A: A power failure occurred while the system was actively recording. Refer to "What 
happens to the unit during a power failure" for details.

Q: What accessories can I add to the system?
You can add extra cameras and a range extender to the unit:
• LW2711AC1 - Accessory Camera
• ACCANTD9 - Accessory range extender antenna for camera or LCD Monitor - directional, 9 dBi
• ACCANTO8 - Accessory range extender (for LCD monitor ONLY)

For details, see “Appendix D: Strengthening the Range of the Wireless Signal” on page 34.
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Frequently Asked Questions
Screen Saver (Picture Frame Simulation)
Q: Can I upload my own pictures onto the LCD receiver?
A: The receiver does not offer the ability to upload your own pictures/videos. It only displays 
the pre-loaded images (five scenery images).

Q: Can I set the LCD receiver to play the pre-loaded images in a slideshow?
A: The LCD receiver will only display the pre-loaded image selected in the OSD menu. To 
change the image, please go to the OSD menu, and select another pre-loaded image.

Q: Can I delete the screen saver images?
A: No. The images are pre-loaded into the monitor, not the SD card. Formatting the SD card 
will not delete the screen saver images. 

Privacy 
Q: Is the signal secure?
A: Yes. The Digital Wireless signal transmission type used by the receiver is also known as 
FHSS- Frequency Hopping Spread Spectrum. This type of signal is highly resistant to 
deliberate jamming as it generates a channel hopping sequence using a sophisticated 
algorithm generated by the receiver system. 

Q: What memory cards is the LCD receiver compatible with?
The system is compatible with SD (Secure Digital) and SDHC (SD High Capacity) memory 
cards, minimum Class 2. 

Q: What is the maximum capacity SD memory card supported?
A: The system supports a maximum of 16 gigabtyes. 

Recording
Q: Can I view remotely and record at the same time?
A: No. You can only view during remote viewing. Local recording is disabled.

Q: Can I record multiple cameras at the same time?
A: The LCD receiver can only record one channel at a time. 
TIP: Set Trigger Record in the Record menu to 5 seconds (the lowest possible value), and 
enable Quad Mode. This allows the system to: a) record a channel for 5 seconds when 
motion is detected b) Records the next channel that detects motion for another 5 seconds.
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Frequently Asked Questions
Q: Why can't I access the main menu while I'm in Quad Mode?
A: You must exit Quad Mode before you can access the main menu. Simply press Quad on 
the remote control to exit.

Q: Why isn't scheduled recording starting? 
• Make sure that the SD card is properly inserted into the monitor. Make sure that the SD card 

icon appears at the top of the screen.
• Double check that you have set the system time. Press the Menu button to access the main 

menu. Then navigate to Setting>Date & Time to set the system time. 
• Double check that you have set the start/stop time in the scheduled recording menu.
• Double check that you have turned scheduled recording on.
• You may be in Quad Mode. Exit Quad Mode before starting scheduled recording. Press the 

Quad button on the remote to exit.

Q: Can I record in Auto Sequence Viewing Mode?
A: Yes. Set the system to Scheduled Recording. Then set the viewing mode to Auto 
Sequence. Note that the recorder only records what it sees on-screen. This means that you 
will only record video from a particular channel when it is displayed on the monitor. 

Q: Can I set specific days of the week for the system to record?
A: You can only specify to record at a particular time of day (for example, everyday from 
9:00 a.m to 5:00 p.m). 

NOTE: System utilizes a 24-hour clock (i.e 15:00 is 3:00pm).
Use the Schedule Record menu to set start and stop times for Schedule Recording. During 
this time block, the system records continuously from one specific camera, or from any 
cameras in Auto Sequence Viewing Mode. 

Q: I noticed that the system is recording back to back video files while in Motion 
Recording setting. Why is that?
A:  Reasons for this could be as follows:

1 The camera(s) may be located in a busy area with lots of movement (i.e. side walk). Either A) 
Change recording setting to Schedule Recording and select a camera which covers the most 
critical area B) Try to point the camera a bit more downwards so it does not pick up as much 
of the (foot) traffic. 

2 When having more than 1 camera set up, you may have 2 or more cameras pointed at the 
exact same area (from  different vantage points). This causes them to pick up motion at the 
same time and create back to back recordings. Change the viewing area of one or more 
cameras so they don't overlap.
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Frequently Asked Questions
Viewing A/V Output 
Q: I connected the A/V output cable to my TV. How do I get the image to appear on the TV?
A: You need to press the AV button on the remote to transfer the image from the receiver 
to the TV/monitor. 

NOTE: It takes approximately 5 seconds for the image to appear on the TV/Monitor.

Q: When using A/V output, can I watch the video on the TV/monitor, and on the receiver 
at the same time?
A: When using A/V output, the LCD screen blacks out. The image only appears on the 
television screen.

System Settings 
Q: Can the system display a 12-hour clock?
A: The unit only displays time in the 24-hour clock format.

Q: Can the system adjust to daylight savings time?
A: There is no daylight savings time (DST) setting on the system. DST must be set manually 
if necessary. 

Video Playback 
Q: Why can't I access the saved video files on my memory card?
A: All recording must be stopped on the system before playing back saved video files. This 
also applies to Quad or screen saver viewing mode.

Q: When using Manual or Scheduled Recording, why does the system generate so many 
video files?
A: The system records video files in 10 minute sessions (i.e. 1 hour recording will be divided 
into 6 separate files.)

The reasons for this are as follows: 
• It makes finding events easier/faster in case you know the approximate timing of the event.
• The system needs time to record the video file to the memory card. Every time a new 10 minute 

session starts, the previous 10 minute session is stored onto the memory card. 
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Frequently Asked Questions
Q: How can I view videos on my computer?
A: Remove the memory card from the monitor and insert it into a compatible SD card 
reader.

If you are using a PC:
•  A window will pop-up asking you whether you would like to browse files on the memory card 

or launch Windows Media Player™. If the pop-up window does not appear, open My Computer 
(Vista: Computer) and find the memory card in the list of drives.

• Find the video file you want to view by looking for the date the event occurred. The file name 
convention indicates the date ("090825" means the file was recorded on August 25, 2009). 
Double-click the file to begin playback in Windows Media Player™ .

• The XviD, DivX, or FFDShow codec may be required if attempting to view the video files in
• Windows Media Player™. You can also view AVI files natively in other media players such as 

VLC and DivX Player.

If you are using a Mac:
• The memory card folder will appear on the desktop. Double-click the folder to open.
• Find the video file you want to view by looking for the date the event occurred. The file name 

convention indicates the date: "090825" (year (09), month (08), date (25)) means the file was 
recorded on August 25, 2009. Double-click the file to begin playback in Quicktime™ .

• Additional codecs may be required if attempting to view AVI files in QuickTime. VLC Player is 
recommended for viewing AVI files on a Mac. VLC is an open-source freeware application 
available at www.videolan.org
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Enhance your security with genuine Lorex products and accessories. 
Order whatever you need at www.lorextechnology.com 

or call 1-888-42-LOREX (1-888-425-6739)

May 9 2011 -  R14

PROTECT EVERYTHING 
THAT MATTERS

Parking Lot

LBC6050

Office

LNZ4001

Home

LDC6050

Restaurant

Home Office

LW2902

Add wired or wireless cameras to expand the 
“Envelope of Protection” for your business, 

your home and your family

Nursery

LW2003

Backyard

LW2201

LW2702

Front Door

LW2301

Drive Way

CVC6950B

Convenience Store

LW2110

Special offer Coupon: MLLLLDCG-CM-OOJICORN


	1. All warnings and instructions in this manual should be followed.
	2. Remove the plug from the outlet before cleaning. Do not use liquid aerosol detergents. Use a water dampened cloth for cleaning.
	3. Do not use this unit in humid or wet places.
	4. Keep enough space around the unit for ventilation. Slots and openings in the storage cabinet should not be blocked.
	5. During lightning storms, or when the unit is not used for a long time, disconnect the power supply, antenna, and cables to protect the unit from electrical surge.
	www.lorextechnology.com
	1. Cameras require a local power outlet.
	2. Local viewing up to 4 cameras simultaneously. Local recording and playback of one camera at a time.
	3. Five preloaded scenery images enable digital picture frame simulation when no motion is detected by the camera. When motion is detected, image changes to the camera detecting motion. No ability to upload your own pictures.
	4. Stated IR Illumination range is based on ideal conditions. Actual range and image clarity depends on installation location, viewing area and light reflection/absorption level of object.
	5. Weather resistant. Not intended for direct exposure to rain or snow. For outdoor applications install under shelter protected from the elements.
	6. Based on line of sight. Actual range will vary depending on obstructions.

	Table of Contents
	1 Wireless Antenna: Position the antenna as needed for best reception.
	2 Wall Hanger: Use hole to hang the LCD Receiver like a picture frame.
	3 Mounting Hole: Attach the included under-the-counter mount to mount the LCD Receiver underneath a counter/cupboard, wall, or ceiling.
	4 Speaker: Speaker for two-way audio.
	5 SD Card Slot: Insert up to a 16GB SD card.
	6 USB Port: Used for Skype connectivity. For details see, page 39.
	7 AV OUT: Connect the Audio/Video cable to view video on an external TV or monitor (optional)
	8 Support Stand: Attach the included support stand to position the LCD receiver like a picture frame.
	9 DC5V: Connect the included power adapter.
	10 Microphone: Microphone for two-way audio.
	11 TALK: Press to talk using the Intercom; release to listen.
	12 Channels/Navigation Joystick: Press to open the Main Menu. Use to change channels within quad view.
	13 MENU: Press to open the main menu.
	14 Power: Slide button to turn the LCD receiver ON/OFF*
	1 Lens: Camera lens.
	2 Microphone: Built-in microphone underneath camera body.
	3 PIR Sensor: Passive IR motion sensor for more accurate motion recording.
	4 Speaker: Speaker for two-way audio.
	5 Night Vision IR: Night vision IR LEDs used for viewing in complete darkness.
	6 Pair: Pairing button. For more details, see “Appendix C: Adding Cameras” on page 33.
	7 Antenna: Wireless antenna.
	8 Power Cable: Connect the included power adapter to the cable extending from the camera.
	1 1 / u/;: Move menu cursor UP; change time settings; start/pause playback; jump to camera 1 while in Quad Mode.
	2 Enter: Confirm menu selections.
	3 4/9: Move menu cursor LEFT; rewind playback; jump to camera 4 while in Quad Mode; decrease
	4 MENU / Back: Press to open the Main Menu; close menu windows.
	5 Record: Press Motion to enable motion recording - system will ONLY record when motion is detected; press=to start/stop manual recording.
	6 Volume: Increase/decrease volume of two-way audio from the receiver; increase/decrease volume during playback.
	7 Quad: Press to change the display view to quad (4-way) split-screen.
	8 2/ :: Move menu cursor RIGHT; increase playback speed; jump to camera 2 while in Quad Mode; increase values in certain menu options.
	9 3/n: Move menu cursor DOWN; change time settings; stop playback; jump to camera 3 while in Quad Mode.
	10 Scan/Del: Press to enable/disable Screen Saver mode; delete recorded video files.
	11 Channel: Press "A" to enable/disable automatic sequence; press M to manually change the channels (1~4).
	12 AV: Press to send the image to a connected TV or monitor (AV cable required)

	Installing the camera
	1 Use the included mounting screws to mount the stand to the mounting surface:
	2 Twist the antenna clockwise onto the antenna port on the side of the camera.
	3 Attach the camera to the mounting stand. Adjust the angle of the camera until the desired view is set. Tighten the thumbscrews to secure the desired camera position.
	4 Connect the black power cable extending from the camera to the cable of the power adapter; plug in the power adapter to an outlet or surge protector.
	1 Attach the Tabletop Stand to the slot on the rear panel and turn counter clockwise until you hear one "click." Continue turning counter clockwise to position the LCD receiver as desired.
	1 Select a location to mount the receiver, i.e. under a counter or cupboard, wall or ceiling. The location should have a clear reception to your camera. Place the mounting stand in the desired mounting position and mark holes for the screws.
	2 Drill the holes, and then mount the stand to the desired surface using the provided screws. Make sure all three screws are fastened tightly at the connection points.
	3 Adjust the antenna on the LCD receiver to allow for proper clearance with your mounting surface.
	4 Attach the LCD receiver to the mounting stand. Adjust the position of the LCD receiver and tighten the bolts with included Allen key.
	1 Connect the cable from the power adapter to the 5V DC port on the bottom panel of the receiver. Plug in the power adapter to an outlet or surge protector.
	2 OPTIONAL: To view the receiver on a television, connect the included AV cable to the AV OUT port on the system. Connect the other end of the cable to the television. For details, see “Viewing A/V Output” on page 55.
	3 Slide the power switch on the rear panel to the "ON" position.
	1 Push the SD card into the SD card slot on the LCD receiver until you hear a "click." The card will not be flush when completely inserted.

	Using the System
	1 File Name: The name of the file actively being recorded. This file will appear in the file list on the SD card. The Recording File stamp indicates the hour, minutes, and seconds that the system started recording.
	2 Signal Indicator: The signal indicator shows the strength of the signal being received from the camera. The number of bars in ...
	3 Recording Indicator: "REC" appears during manual, motion, and schedule recording.
	4 SD Card icon: A white "SD" icon displays that an SD card is in the wireless receiver.
	5 Power Failure icon: Flashing icon indicates a power failure has occurred on the system. You may need to manually restore settings or modes on the system after a power failure. For details, see “Appendix G: Power Failure Indicator” on page 38.
	6 File Icon: Flashes yellow when writing data to the SD card. Flashes red when the SD card is full.
	7 Camera indicator: Displays the camera you are presently viewing; position of camera indicators shifts to the left side of the screen while in Quad mode.
	8 Time Stamp: The current date and time on the system.
	1 Press the Channel A button on the remote to enable Auto Sequence Viewing Mode and switch automatically between channels.
	2 Press the Channel M button on the remote to disable Auto Sequence.
	1 Press the Channel M button on the remote repeatedly to switch between channels 1~4
	1 Press the QUAD button on the remote. The Schedule Recording warning appears briefly on-screen, then the Quad display mode begins.
	1 Press the MENU button to open the Main Menu.
	2 From the Main Menu, select Setting and press the Enter button on the remote.
	3 From the Settings menu, select Screen Saver and press the Enter button on the remote.
	4 From the Screen Saver menu, select Blank screen or Picture 1~5 and press the Enter button on the remote.
	5 Press the MENU button on the remote until all menu windows are closed.
	6 Press the Scan/Del button on the remote to activate Screen Saver Mode. One of the selected images will appear on the LCD receiver and "SCAN" will light up on the bottom of the LCD receiver.
	7 Press the Scan/Del button on the remote again to disable Screen Saver mode.
	1 From live viewing, press the Motion button on the remote."AUTO REC" appears on the LCD receiver.
	2 Press the Scan/Del button to enable the Screen Saver. "SCAN" appears on the LCD receiver.
	1 From the Main Menu, select Setting and press the Enter button on the remote.
	2 From the Setting menu, select Date & Time and press the Enter button on the remote.
	3 Press RIGHT/LEFT to move the cursor; press UP/ DOWN to change the year, month, day, hour, minutes, and seconds.
	4 Press Enter on the remote to save your settings.
	5 Press MENU on the remote to close any remaining menu windows.

	Recording
	1 An SD card must be inserted in the wireless receiver in order to record. You should always format the SD card prior to initial recording. For details, see “Format” on page 30.
	2 Recording overrides other actions on the receiver. You must stop recording on the system in order to perform other actions, such as opening the Main Menu, Quad Mode, etc.
	1 Select a channel (1~4) on the wireless receiver or from the remote control.
	2 Press the Record button (=) on the remote control.
	3 To stop Manual Recording, press the Record button (=) again. "NEW" will appear on the LCD receiver indicating a new file is on the SD card.
	1 Press the MENU button on the remote to open the Main Menu.
	2 Select Record and press the Enter button.
	3 Using the remote, press RIGHT/LEFT to move the cursor (yellow); press UP/DOWN to change the hour and the minutes.
	4 Press the Enter button on the remote to save your schedule.
	5 Press MENU on the remote until all menu windows are closed.
	1 Disable ALL RECORDING on the system:
	2 Select a channel (1~4) from the remote control.
	3 When the Start Time arrives, recording begins. The "REC" indicator appears on-screen.
	1 Press the Record button (=) on the remote control to stop schedule recording.
	1 During live view, press the Motion button on the remote control.
	2 Perform one of the following:
	3 Press the Motion button on the remote again to stop Motion Recording. "AUTO REC" will turn off on the receiver.
	1 Stop all recording on the system.
	2 Press the Enter button on the remote. The File menu opens.
	3 Select the VIDEO folder and press Enter button on the remote.
	4 Select a folder and press the Enter button on the remote. Folders are labeled by date (yymmdd): e.g. 080512. Select [. .] and press the Enter button on the remote to go up a level.
	5 Select a file from the list and press the Enter button on the remote. The selected file loads and playback begins.
	1 Remove the SD card from the wireless receiver by gently pushing on the SD card. The SD card will pop out from the slot.
	2 Insert the SD card into an SD card reader (not included) connected to your PC. Your PC should load the SD card as a new Removable Drive.
	3 View files and folders on the SD card. You should see a folder labeled "VIDEO."
	4 Open the VIDEO folder and then open one of the Date folders (yymmdd). The AVI file list appears.
	5 Double-click any of the AVI files. The video will begin playing in your default AVI media player.
	1 Remove the SD card from the wireless receiver by gently pushing on the SD card. The SD card will pop out from the slot.
	2 Insert the SD card into an SD card reader (not included) connected to your Mac. Your Mac should load the SD card as a new Disk Image.
	3 View files and folders on the SD card. You should see a folder labeled "VIDEO."
	4 Open the VIDEO folder and then open one of the Date folders (yymmdd). The AVI file list appears.
	5 Double-click any of the AVI files. The video will begin playing in your default AVI media player.
	1 Press and hold the TALK button on the back of the LCD receiver. An audio icon appears on-screen.
	2 Talk in a normal speaking voice close to the LCD screen (approximately 12 in. / 30 cm).
	3 Release the TALK button to hear a response from the camera(s).
	1 From live viewing, press the Vol+ button to increase system volume.
	2 Press the Vol- button to decrease system volume.

	Using the Main Menu
	1 From the Main Menu, select Camera On/ Off and press the Enter button on the remote.
	2 Select the desired camera and press RIGHT/LEFT to select On or Off.
	3 Press the Enter button on the remote.
	4 Press the MENU button on the remote to exit.
	1 From the Main Menu, select Record and press the Enter button on the remote.
	2 From the record menu, select Quality and press the Enter button on the remote.
	3 Press LEFT/RIGHT to select 320x480 (QVGA) or 640x480 (VGA).
	4 Press the Enter button on the remote to save your settings.
	5 Press the MENU button on the remote until all menu windows are closed.
	1 From the Main Menu select Record and press the Enter button on the remote.
	2 From the Record menu select Trigger Record and press the Enter button on the remote.
	3 Select 5 seconds, 15 Seconds, or 30 Seconds and press the Enter button.
	4 Press the MENU button until all menu windows are closed.
	1 From the Main Menu, select Record and press the Enter button.
	2 From the Record menu, select Schedule Record and press the Enter button.
	3 Press RIGHT/LEFT to move the cursor (yellow); press UP/DOWN to change the hour and the minutes.
	4 Press the Enter button on the remote to save your schedule.
	5 Press the MENU button on the remote until all menu windows are closed.
	6 Disable Manual and Motion Recording on the system.
	1 From the Main Menu select Record and press the Enter button on the remote.
	2 From the record Menu select Overwrite and press the Enter button on the remote.
	3 Select Yes and press the Enter button on the remote.
	4 Press the Menu button until all menu windows are closed.
	1 Connect the camera to a power outlet. Place the camera and LCD receiver within 1 ft of each other.
	2 Press MENU on the wireless receiver or remote control.
	3 From the Main Menu, select Pairing and press the Enter button on the remote.
	4 Select Camera 2, Camera 3, or Camera 4 and press the Enter button on the remote.
	5 Following the on-screen prompt, press the Pair button on the rear panel of the camera. You have 30 seconds to press the PAIR button on the camera. Once paired, the camera will be immediately displayed on-screen.
	1 From the Main Menu, select Setting and press the Enter button on the remote.
	2 From the Setting menu, select Date & Time and press the Enter button on the remote.
	3 Press RIGHT/LEFT to move the cursor; press UP/DOWN to change the year, month, day, hour, minutes, and seconds.
	4 Press the Enter button on the remote to save your settings.
	5 Press the MENU button on the remote until all menu windows are closed.
	1 From the Main Menu, select Setting and press the Enter button on the remote.
	2 From the Settings menu, select Brightness and press the Enter button on the remote.
	3 Press LEFT/RIGHT to increase and decrease the brightness.
	4 Press the Enter button on the remote to save your settings.
	5 Press the MENU button on the remote until all menu windows are closed.
	1 From the Main Menu, select Setting and press the Enter button on the remote.
	2 From the Settings menu, select AV out and press the Enter button on the remote.
	3 Select NTSC (North America) or PAL (UK/ Europe) and press the Enter button on the remote.
	4 Press the MENU button on the remote until all menu windows are closed.
	1 From the Main Menu, select Setting and press the Enter button on the remote.
	2 From the Settings menu, select Screen Saver and press the Enter button on the remote.
	3 From the Screen Saver menu, select None (black) or Picture 1~5 and press the Enter button on the remote.
	4 Press the MENU button on the remote until all menu windows are closed.
	1 Press the Scan/Del button on the remote. The selected image appears on the LCD screen.
	2 Press the Scan/Del button on the remote again to disable the Screen Saver and return to live viewing.
	1 From the Main Menu, select Setting and press the Enter button.
	2 From the Settings menu, select Alarm Volume and press the Enter button on the remote.
	3 Press RIGHT to increase the alarm volume, and press LEFT to decrease the alarm volume.
	4 Press the Enter button on the remote to save your settings.
	5 Press the MENU button on the remote until all menu windows are closed.
	1 View camera 1, 2, 3 or 4 in single-channel full-screen.
	2 From the Main Menu, select Setting and press the Enter button on the remote.
	3 From the Settings menu, select Zoom and press the Enter button on the remote.
	4 Select X 1 or X 2 and press the Enter button on the remote.
	5 Press the MENU button until all menu windows are closed. The selected camera will be shown on the main display in 2X zoom.
	1 Open the Zoom menu.
	2 Select X 1 and press the Enter button on the remote.
	3 Press the MENU button on the remote until all menu windows are closed.
	1 Insert the SD card into the SD card slot on the wireless receiver until you hear a "click." Please insert the card according to the diagram on the panel.
	2 From the Main Menu, select Setting and press the Enter button on the remote.
	3 From the Settings menu, select Format and press the Enter button on the remote.
	4 Select Yes and press the Enter button on the remote. Please allow a few moments for formatting to finish. Formatting time will vary depending on the size of the SD card.
	1 From the Main Menu, select Setting and press the Enter button on the remote.
	2 From the Settings menu, select Factory Reset and press the Enter button on the remote.
	3 Select Yes and press the Enter button on the remote.
	4 Press the MENU button on the remote until all menu windows are closed.

	Appendix A: System Specifications
	Appendix B: About Digital Wireless Technology
	Appendix C: Adding Cameras
	1 Connect the new camera to a power outlet. Place the camera and LCD receiver within 1 ft of each other.
	2 Press MENU on the wireless receiver or remote control.
	3 From the Main Menu, select Pairing and press the Enter button on the remote.
	4 Select a channel and press the Enter button on the remote.
	5 Following the on-screen prompt, press the Pair button behind the camera. You have 30 seconds to press the Pair button on the camera. Once paired, the camera will be immediately displayed on-screen.

	Appendix D: Strengthening the Range of the Wireless Signal
	Appendix E: Deleting Video Files on the System
	1 From live viewing, press the Enter button on the remote. The File menu opens.
	2 Select the VIDEO folder and press the Enter button on the remote.
	3 Select a Date folder and press the Enter button on the remote. The file list opens.
	4 Select a file and press the Scan/Del button on the remote.
	5 At the prompt, select YES and press the Enter button on the remote. The file is deleted and the File List returns as normal.
	6 Repeat steps 3~5 for other files on the SD card.

	Appendix F: Estimated Recording Times on SD Cards
	Appendix G: Power Failure Indicator
	Appendix H: Viewing your camera remotely using Skype
	1 Insert the software CD into the computer. An autoplay window opens.
	2 Click Run Lorex.exe.
	3 Click the USB Driver button, then click USB Driver. The driver will appear on your desktop.
	4 Click the X button () to close the window.
	5 Double-click the Usbdriver icon () on your desktop.
	6 Follow the on-screen instructions to complete the driver installation.
	1 Turn on the camera first, then the video monitor. Make sure you can see a video image on channel 1.
	2 Connect the USB cable (included) to your video monitor and into the computer’s USB port. The video monitor displays the following: "USB PC CAMERA MODE"
	1 Launch Skype. If you are connected to Skype, click Skype>Sign Out.
	2 From the Skype Login window, click Don’t have a Skype name?
	3 Follow the on-screen instructions to create a new camera account (i.e. Lorex Camera) or an account for yourself (i.e. Tom Smith).
	4 Upon login, click the See my video button to confirm that Skype detects the camera.
	5 Click the Close button to exit.
	6 Click on Tools>Options.
	7 Click the Calls button ().
	8 Click the Show advanced options button.
	9 Select the "Answer incoming calls automatically" checkbox and the "Start my video automatically when I am in a call" check box. Click Save.
	1 Click the Add a contact button ().
	2 Search for the name of your personal account (i.e. Tom Smith), and then click the Add button.
	3 Click Send Request.
	1 Log in to your personal account (i.e Tom Smith).
	2 A "new contact" pop-up appears. Click the new contact request icon that appears on the bottom-right corner of the window.
	3 Click the Add to Contacts button to add the camera to your contact list.
	4 From the contact list, right-click on your camera’s account name (i.e. Lorex Camera), and click Call.
	1 Go to www.skype.com, and click on Join Skype.
	2 Click Create Account. Fill in the appropriate fields.
	3 Click the I Agree - Continue button.
	4 Follow the on-screen instructions to download and install Skype on your computer.
	5 Once you are logged in to Skype, click on Skype>Sign out, then see “If you have an existing Skype account” on page 42 .
	1 Download and install the mobile Skype application from the mobile application store (i.e. App Store for the iPhone).
	2 Launch Skype and tap Contacts.
	3 Select the video monitor’s account, and tap Video Call to connect to the camera.

	Troubleshooting
	Frequently Asked Questions
	1 Press the Menu button on the remote.
	2 Navigate to Setting>Alarm Volume
	3 Press the back (number 4) button repeatedly on the remote to turn the volume all the way down. Note: One volume bar means the alarm sound is muted.
	4 Press Enter on the remote.
	1 The camera(s) may be located in a busy area with lots of movement (i.e. side walk). Either A) Change recording setting to Sche...
	2 When having more than 1 camera set up, you may have 2 or more cameras pointed at the exact same area (from different vantage p...

	Getting Started



